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Streaming Server 2025 Introduction
About Streaming Server
Looking at video content remotely at reference quality, from as early as initial camera and make-up tests
all the way up to final localized deliverables, has become exceptionally important.

Colorfront’s advanced Streaming Server appliance offers a solution for professional remote video and
audio monitoring with secure, reference-quality and low latency viewing experience that is suitable for
critical QC or client approval, and supports a range of display options including: Apple’s XDR display, OLED
TVs, professional HDR reference monitors or even emissive cinema walls.

The Streaming Server appliance

Key Features of Streaming Server
• Reference quality 10-bit 444 HEVC video stream

• Sub-second latency for truly interactive sessions

• Secure transport with 128/256-bit AES encryption

• Optional forensic and visible watermaking

• Flexible data rates from below 10 up to multiple hundreds of Mbps

• Rec.709 and PQ color space support

• Dolby Vision tunneling
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• UI and web control

• Multi audio channels up to 16 channels

• Secondary stream via WebRTC or external gateway

To view the stream generated by the server, Colorfront provides a simple, easy-to-use, thin Client
Application, the Streaming Player that supports both Windows and macOS platforms. For the best
quality, it is recommended that you use a professional video output device connected to the client
computer to interface with the monitor.

The Streaming Player application

Contact Customer Support
All information with regard to COLORFRONT’s Streaming Server software application can be found on the
COLORFRONT website. Should any issues or questions arise, please contact Customer Support so that we
can assist you as efficiently as possible. Our contact information:

Web: http://www.colorfront.com

Help Center: http://support.colorfront.com

Email: support@colorfront.com

Discord: https://discord.gg/cfsupport

To help us support you as efficiently as possible, please read chapter Troubleshooting.
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About COLORFRONT
COLORFRONT, based in Budapest, Hungary, is one of Europe’s leading post-production facilities. The
company was founded by brothers Mark and Aron Jaszberenyi, who together played a pivotal role in the
emergence of non-linear digital intermediate. The company’s R&D team earned an Academy Award for
the development of Lustre, Autodesk’s DI grading system, and a Primetime Engineering Emmy for
COLORFRONT On-Set Dailies. Combining this in-depth expertise with a pedigree in the development of
additional cutting-edge software, COLORFRONT offers today’s most advanced technologies for scanning
and recording, DI grading, conforming, digital dailies, VFX, online and offline editing, cinema sound
mixing, mastering and deliverables. For more information, please visit https://docs.colorfront.cloud.
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1. Getting Started
Please take the following steps upon receiving the Colorfront Streaming Server hardware unit:

1. Rack mount the unit wherever it is ideally suited for your facility/testing.

2. Connect the power supply.

3. Run 4xSDI cables into the video i/o card.

4. Run 1xEthernet cable to the bottom left port on the back of the chassis.

5. Connect a DisplayPort-capable display (only needed for original setup) so you can get the TeamViewer
details as well as the IP address.

6. Power up the system. It will automatically log in the user and launch the software.

4



2. Streaming Network Architectures
The remote streaming technology relies on various components that facilitate the deployment of a wide
range of workflows and configurations. These key building blocks include:

• Streaming sources, such as the Streaming Server (StS) SDI appliance, the Colorfront Streamer
application, the StS software within Amazon AWS, or other Colorfront dailies or mastering products.

• The Stream Manager, which offers a user-friendly interface for session management and invitations.

• Streaming Player applications, designed to view the reference-quality output.

• A gateway, which transmits SRT streams to multiple destinations. Users can leverage Colorfront’s
high-security, high-performance Gateway or opt for direct streaming through a P2P setup.

Various components of streaming configurations

Many configurations can be built from these components. For illustration, we present the following
examples for streaming with the Streaming Server:

• Streaming via Colorfront’s Stream Manager interface

• Direct (P2P) streaming between the server and the player components, without using an external
gateway

Learn how to configure the different settings for each type in the Network Configuration section.
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2.1. Streaming Sources
Streaming sources are essential elements of remote streaming technology, serving as the foundation for
various workflows and configurations. These sources encompass a diverse range of components designed
to facilitate seamless deployment. Key streaming sources include:

Streaming Server appliance This dedicated hardware SDI appliance offers robust streaming
capabilities, ensuring reliable performance and seamless
integration with existing infrastructure. It enables direct
streaming of high-quality content, making it ideal for demanding
production environments.

Streaming via Colorfront products Colorfront’s mastering and dailies products, such as Transkoder
or On-Set Dailies, feature built-in streaming functionality. This
enables seamless streaming to Streaming Player applications,
with operators configuring the stream within the software
settings, similar to configuring local video output.

Streaming Server in AWS The Streaming Server within Amazon AWS provides scalable and
flexible streaming solutions. This cloud-based solution offers
remote access to EC2 instances within the AWS infrastructure,
functioning as a virtual streaming source with the same high-
quality capabilities as the StS appliance.

2.2. Streaming via Stream Manager
For SRT streaming, Streaming Server uses Colorfront’s proprietary Stream Manager, which acts as an
intermediary between the streaming source and the client. Its advantages are:

• simpler firewall configuration; generally does not require open ports (See Security Hardening for more
details.)

• scales with demand without additional bandwidth pressure on the local network

• studio-level security with individual email invites that cannot be shared

• session management and real-time monitoring of connected clients

6



Streaming workflow via Colorfront’s Stream Manager

See Stream Manager for more details.

2.3. Direct Streaming
Direct, or point-to-point (P2P) streaming allows multiple clients to connect directly to a single server
concurrently through a point-to-multipoint connection, keeping the video stream within a private network
and avoiding transmission over the public internet. This method is particularly relevant in scenarios where
a company or studio’s security policy requires that all streaming data remains within a closed network or
when working offline is necessary.

In any streaming setup, Streaming Server accesses the source digital media directly, whether stored on-
premise or in the cloud, while the client Streaming Player applications run locally on users' computers.
What distinguishes P2P streaming from the traditional streaming setup is that it avoids external
gateways, transmitting video content directly between the server and clients, ensuring the stream
remains within the private network.

While P2P streaming operates independently, a Stream Manager can be used to facilitate session
management and connection setup between the server and clients.


It is important to note that the Stream Manager acts solely as a facilitator for connection
setup and session management; it does not handle or route the actual video stream.

Point-to-point streaming uses bi-directional UDP communication, where the server connects directly to a
client’s listening socket over a private network or, if necessary, the public internet. The content is
transmitted as an encrypted MPEG-TS stream within the SRT (Secure Reliable Transport) protocol,
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enhancing reliability and security against network fluctuations. For this configuration, you may need to set
up a VPN or similar secure connection, and ensure that the necessary ports are open on the firewall.

Refer to P2P Streaming Configuration for instructions on configuring P2P streaming for the Streaming
Server.

Direct streaming configuration
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3. GUI Overview
Streaming Server has a four-quadrant configurable layout that allows the operator to check relevant
information about the input and the stream status simultaneously. Alternatively, you can switch to Four-
Channel View.

The system can also be controlled via a Web Control Interface.

Four-quadrant layout of the Streaming Server

3.1. Quadrant Views
As a default, the initial four quadrants in the GUI are:

• Q1 - Waveform

• Q2 - Streaming Status

• Q3 - Video Image

• Q4 - Info

Right-click on any quadrant of the screen and switch to another view from the pop-up menu.

Selecting various quadrant views from the context menu

The available quadrant views are:
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Image shows the video image with applicable LUTs

Waveform illustrates both luminance and color information in a basic lumi color
waveform graph

Audio small volume meter to monitor playback volume levels up to 16 channels

Info displays video characteristics such as input color space, dynamic range or
frame drop count

Dolby Vision Metadata presents Dolby Vision metadata if detected

Streaming Status various status information indicating the stream’s health



By default, the Streaming Status view shows the status of
the first two streaming channels if Channel (see below) is
set to Channel 1 or 2.
To view the streaming status of the third and fourth
channels, set the channel to either 3 or 4.

Stream Log monitors the streaming and provides basic stream information for each
channel

System Log general system log for tracking and alerting to potential system issues and
problems

Channel defines which channel’s attributes are displayed when any view option is
selected for the specific quadrant

For multiple input channels, for example, a layout of two video streams and two stream logs, or even four
different video images can be configured for the four quadrants.

The quadrant layout can also be controlled from the top menu. Use the Streaming Server › Tools ›
Q1/Q2/Q3/Q4 menu options to select the view for each quadrant and to specify the appropriate channel.

Selecting various quadrant views from the top menu

3.1.1. Keyboard Shortcuts for Quadrants

Various keyboard shortcuts are available to switch between channels assigned to a given quadrant (Q1,
Q2, etc.), or to toggle between different quadrant views, as shown in the table below.
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GUI shortcuts for quadrants

Shortcut Operation

F5 Toggles between quadrant views for Q1

F6 Toggles between quadrant views for Q2

F7 Toggles between quadrant views for Q3

F8 Toggles between quadrant views for Q4

F9 Toggles between channels 1-4 for Q1

F10 Toggles between channels 1-4 for Q2

F11 Toggles between channels 1-4 for Q3

F12 Toggles between channels 1-4 for Q4

See more in Keyboard Shortcuts.

3.2. Four-Channel View
The four-channel view mode is a valuable tool for simultaneously monitoring all four streaming channels
side by side. You can easily toggle this view by using the Shift+Enter keyboard combination, and see the
streaming status, audio volume meters, and video images for each of the available streams. Alternatively,

you can access this feature via the Streaming Server › Tools › Four Channel View menu option.

Four-channel view mode
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3.3. Create Custom Layouts
Streaming Server’s Setup ›   menu allows you to create different layouts of the four quadrants.

Setup menu for creating, selecting or deleting layout setups

Create Setup Set each of the four quadrants to the appropriate view, and then use this
menu option to save it as a new layout.

Open Setup After creating a custom layout/setup, switch between the available setups
listed.

Delete Current Setup Deletes the currently selected setup.

Delete 'custom' Setup Deletes the indicated setup.

Reset 'custom' Setup Resets the indicated setup to the default view, which is the following:

• Q1 - Waveform

• Q2 - Streaming Status

• Q3 - Video Image

• Q4 - Info

12



4. Input Configurations
4.1. Video Input
Individual video inputs may have different resolution or color space parameters, which can be configured
independently. The Video menu is used for specifying the characteristics of the video signal coming from

an SDI link. You can also configure the characteristics of all SDI inputs at once by using the Video › All SDI
Inputs menu option that has the same sub-menus.

Specifying characteristics for SDI video inputs

Use the Video › SDI 1/2/3/4 menu options to configure the following parameters:

Resolution Match the input signal resolution to the source from [720p] up to [8K].

Color Space Select from [YCbCr 10-bit], [RGB 10-bit] or [RGB 12-bit] color space options.
There is also a [RGB Range is Legal] option for RGB 444 mode.

Transport Apply [Single-link], [Dual-link] or [Quad-link] transport.



When using quad-wire SDI setup for UHD/4K signals, the quad-
link transport mode will be set for the first input channel.

For dual-link setup, the first or the third input channel will be set,
as the signal will be transported via either channels 1 and 2, or
channels 3 and 4.

4K Pixel Mapping For UHD/4K source, select [Square Division] or [Two-Sample Interleave] pixel
mapping.

Auto Detect Choose this option to follow the source video parameters.

4.1.1. SDI Input Modes

Streaming Server is capable of simultaneously capturing, encoding and streaming four HD or UHD signals.

Using the Video › Input Setup menu option, you can specify whether to use quad-link SDI or four separate
SDI input modes, as per the following:

Quad-link SDI Input The four SDI signals are combined to result in full UHD/4K/8K resolution video.
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Four SDI Input Four independent input signals result in four separate video image. Use this
setting to display four separate HD or UHD video.

Selecting quad-link or four SDI input modes

4.1.2. Stereo Streaming

Streaming Server supports the streaming of stereo 3D content, which is served by two input options:

Stereo SDI inputs It captures and directly streams Colorfront’s Transkoder’s stereo
SDI output, where both SDI 1,2 and SDI 3,4 will be stereo.

Dual Input from Davinci Resolve 3D stereo images are captured from the DaVinci Resolve system.
See Setting up Resolve for Stereo Output.



Make sure that SDIs 1 and 2 from Resolve are
routed to SDI ports 3 and 4 on the Blackmagic
Design Decklink 8K Pro card of the Streaming
Server.

Setting up stereo 3D streaming in Streaming Server

Limitations

The limitations to stereo 3D streaming are the following:

• Stereo capture in Streaming Server only works with the Blackmagic 8K Pro video card.

• Stereo playback with the Streaming Player is AJA only. See details in View Stereo Stream with the
Streaming Player.

• Stereo capture and playback is HD/2K only.

• Both the left and right eyes must be assigned to a channel in the Streaming Server. The right eye’s
channel will show 'no input' on the GUI as it will be used by the left eye’s channel.

• Before switching between the Video › Input Setup options, the stream must be manually stopped.
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Stereo Configuration

To configure stereo streaming with the Streaming Server:

1. Open Streaming Server with the supported build version.

2. Select the appropriate input configuration using the Video › Input Setup › Stereo SDI Inputs or   ›
Dual-Input SDI menu option.

3. Click the [START STREAM] button. When the connection is established, the Streaming Status shows
that the input and the stream are stereo.

4. After the stereo input is configured in the Streaming Server, view the stereo stream using the
Streaming Player. See the next section.

View Stereo Stream with the Streaming Player

The stereo stream can be viewed using the Streaming Player. For stereo video output, the Streaming
Player must be equipped with AJA Kona 5 video device with 4K firmware.

To switch between left and right eye views, use the Ctrl+F2 and Ctrl+F3 key combinations.


Monitoring a stereo data stream with the Streaming Player is currently only available on
Windows systems.

Setting up Resolve for Stereo Output

Stereo streaming is also supported using a special configuration that involves sending stereo streams
from a DaVinci Resolve Studio system to the Streaming Server, and then transferring the 3D images to the
Streaming Player for viewing.

First, set up DaVinci Resolve Studio to output stereo 3D images as follows:
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1. On the computer running DaVinci Resolve, connect the SDI cables to the Streaming Server’s
Blackmagic Design Decklink 8K Pro device:

◦ Route SDI 1 and 2 to SDI ports 3 and 4 on the Streaming Server’s Blackmagic Design card.


Currently, for 3D stereo streaming, both the video card of the computer with
DaVinci Resolve and the Streaming Server video card must be Blackmagic Design
Decklink 8K Pro devices.

2. In Resolve Studio, create a new project.

3. Select the Edit page at the bottom and create three new bins named L, R, Output (Left, Right, Stereo).

4. Drag and drop each media to the relevant Left and Right bins.

5. Then right-click in the area where the large folder icons are and select Stereo 3D Sync…

6. In the pop-up window, click the [Browse] buttons to select the left and right eye and stereo output
folders, and then press [Sync].
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7. Open the Output bin right click on the media.

8. Select Create New Timeline Using Selected Clips.

9. At the bottom of the screen, switch to the Color page.

10. Select 3D and set Vision to [Stereo]. In addition, make sure that Out is set to [None].

11. Go to the Project Settings, and set the Video format to [2K 1080p 48]. Select the Use dual outputs on
SDI and Single link options. Also, make sure the timeline resolution and the frame rates match.
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4.2. Audio Input
Streaming Server supports multichannel configurations up to 16 audio data channels. Both AAC and PCM
audio outputs are supported for streaming.



PCM (Pulse Code Modulation) is an uncompressed and lossless audio format where the
raw analog audio signals are sampled and recorded at certain intervals (or pulses). The
PCM audio codec does not include audio compression, which provides very high fidelity to
the original audio, although streaming these large audio files requires a lot of extra
bandwidth.

AAC, on the other hand, stands for Advanced Audio Coding and is a lossy digital audio
encoding standard. This compression codec is newer and more advanced format than MP3
and provides better sound quality.

For streaming via the Streaming Server, you can configure the following audio parameters in the
Advanced Streaming Channel 1-4 Settings:

Audio Encoder Set to [AAC] or [PCM] format

Audio Channel Count Set to [8] or [16] audio channels
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Audio streaming settings on the Settings Page

4.3. Supported Hardware and Configuration
Streaming Server supports a variety of video devices, including Blackmagic Design Decklink SDI 4K and
Decklink 8K Pro, which can be used alternately in the same system.

Supported AJA and Blackmagic Design video cards are:

• AJA KONA 4

• AJA KONA 5

• AJA Corvid 44/88

• AJA T-Tap Pro (AJA Peek only)

• AJA Io 4K

• AJA Io 4K Plus

• AJA Kona IP (AJA Peek only)

• BMD DeckLink 8K Pro

• BMD DeckLink Quad HDMI

• BMD Decklink Mini Recorder 4K

• BMD Decklink Mini Recorder HD

• BMD DeckLink Duo 2

• BMD DeckLink Duo 2 Mini

• BMD DeckLink 4K Extreme 12G

• BMD SDI 4K

• BMD Studio 4K

• BMD Ultrastudio 4K Mini

• BMD UltraStudio Recorder 3G

• BMD UltraStudio 4K Extreme 3

• BMD UltraStudio HD Mini
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5. Stream Manager
The Stream Manager is accessible via any web browser at: https://stream.colorfront.cloud

To get started, log in with your username and password.

For regular users, the Stream Manager provides access to the Streams Page, which lists all available
stream sessions for the user’s team(s) with detailed information on the selected session, stream
parameters, active and inactive viewers, invitation options, and related metadata.

Stream Manager main view

When accessed with Team Manager Privileges, the Stream Manager interface offers additional
management options. Team Managers can configure team preferences, manage members, and
administer streaming servers.

See the following chapters for additional details:

• Streams Page

• Starting Streams From Stream Manager

• Inviting Viewers

• Managing Viewers

• Monitoring Streams

• Team Manager Privileges

5.1. Streams Page
The Stream Manager’s main view displays all configured stream sessions for the user’s team(s) in the left
panel, with the associated session details in the right panel. You can mark your favorite streams by
selecting the star icon, which will position them at the top of the list.
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On the right, you can see the available streaming channels for the selected stream, up to four channels.
The channel header shows the channel name, stream specs, two arrow icons indicating connection status
(green when connected), the number of active viewers, and more.

Stream channel details in the Stream Manager

At the end of each channel entry, three buttons are available:

• [Invite] – Send invitations to the session. For details, see Inviting Viewers.

• Play button – Join the session using the Streaming Player or a connected device. Refer to Joining
Session via URL.

• Info button – Display channel details for the stream and its viewers, along with selectable graphs. For
more information, see Monitoring Streams.

When viewers are connected to the stream, the right arrow turns green, and active viewers are listed for
the channel.


When viewers are connected, you can track their status, device information, and activity
directly in the Stream Manager. For details on how to monitor and manage connected
viewers, see Managing Viewers.

Stream viewers list
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5.2. Starting Streams From Stream Manager
Apart from initiating streaming via the Streaming Server or from Colorfront products such as Transkoder
or QC Player, you can also start streaming sessions directly from the Stream Manager.

Start a streaming session in Stream Manager

To start a streaming session:

1. Open the Stream Manager to display the Streams Page.

2. Select the stream source from the left panel, then click the preferred stream channel on the right to
reveal detailed information.

3. If the input stream is available (the Streaming Server or Streamer is not offline) and no session is
active, you can start it as follows:

◦ Click the cogwheel button to configure stream parameters. For details, see Configuring Streams.

◦ After configuration, either start the session from that panel or click [Save settings] and then [Start
session] on the Streams Page.

◦ Invite viewers as described in Inviting Viewers.

4. To stop the stream, click the red [Stop session] button.


Stopping the stream immediately disconnects all viewers. This action cannot be
undone.

Stopping a streaming session

5.2.1. Configuring Streams

To configure a stream in the Stream Manager, click the cogwheel next to the [Start session] button.
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Configuring a stream in Stream Manager

Stream settings panel

Configurable parameters include:

Preset Save the current configuration as a named preset using the Save
icon. Click the Load preset button to recall a preset from the list.
To delete a preset, click the Delete icon.

Selecting a saved preset

Share preset with team members Enable to share the preset with team members (if available).

Session name Add a custom session name.
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Lock session Restrict management of the session to yourself and Team
Managers.

Bitrate Select from available presets (5–35 Mbps) or enter a custom value
up to 200 Mbps.

Video Chroma Format Choose [4:2:0] or [4:4:4].

Visible Watermark Apply a visible watermark burned into the image for content
protection.

Forensic Watermarking Toggle [On] / [Off] to enable or disable forensic watermarking.

Show Advanced Settings Toggle to display additional options.

Advanced stream settings

Advanced settings:

Resolution Set to [HD] , [2K], [UHD], [4K], or [SameAsSource].

Input Color Space Options include [Auto], [HD709], [HDR10], [P3D65PQ], [HLG],
[P3DCIGamma26], [XYZGamma26], [P3D65Gamma26], and
[Bypass].

Output Color Space Same options as above plus [Dolby Vision]

Audio Encoder [AAC] or [PCM]

Audio Channel Count [8] or [16]
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Visible Watermark Transparency Adjust the opacity of the visible watermark (0–100%).

External Video Output [Allowed] or [Prohibited]

Once configuration is complete, click [Save settings] and then [Start session].

5.3. Inviting Viewers
The Stream Manager provides several ways to invite viewers to a streaming session. You can invite any
number of viewers to a channel. The available methods are:

• Email Invites

• Joining Session via URL

• Easy Join

For details on viewer monitoring and management, see Managing Viewers.

5.3.1. Email Invites

To invite viewers to a stream session from the Stream Manager, follow these steps:

1. On the Streams Page, click the blue [Invite] button next to the selected channel. This opens a panel on
the left where you can add viewers.

Inviting viewers

2. In the panel, enter one or more email addresses as recipients. You can also add a session title and
invitation text for the email.

 Ensure that all email addresses are entered correctly.
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Sending email invites

3. To simplify the process, you can load saved viewer lists in the Send Invitations panel by clicking the
group icon. In the pop-up panel, click [Load viewers from files] to import a list in .txt or .csc format, or
select a list from [Saved viewer lists].

Load viewers from saved list

4. Enable Single use only to restrict viewers to a single device (computer, iPad, etc.). In this mode,
viewers are limited to a single device. By default, multiple devices can be used simultaneously.

5. Enable StP Authentication to add an extra layer of security and verify the viewer’s identity. When
enabled, invited viewers must complete a two-factor authentication process:
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a. After receiving the email invites, the viewer clicks [Join Session] to open the Streaming Player
application.

b. A pop-up window appears with the viewer’s email address pre-filled.

c. The viewer clicks [Submit], and a verification email is sent containing a one-time code.

d. The viewer enters this code into the authentication pop-up and clicks [Submit] again. The stream
begins once the code is verified.

6. When all recipients and options are set, click [Send invitations]. Each recipient will automatically
receive an email notification with a link to join the stream.

Invite via email

5.3.2. Joining Session via URL

You can also join a streaming session using invite URLs generated on the Streams Page of the Stream
Manager. Click the Play button next to the name of the selected streaming channel.

Joining a session via URL

A panel appears on the left, where you have the following options to join the stream:
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Join session options

Join with Streaming Player • Click the Copy to clipboard icon to copy the URL and paste it into a
web browser. The browser will open the Streaming Player.

• Click the Play button to launch the Streaming Player directly and
start viewing the stream on your current computer.

Join with device Click to Play button in the Streaming Player app on your device, and
enter here the six-character authentication code provided to join the

Easy Join code Copy and share the code for Easy Join.

Join from the browser • Click the Copy to clipboard icon to copy the URL and paste it into a
web browser. The Colorfront Viewer loads in the page and plays the
stream.

• Click the Play button to launch the Colorfront Viewer directly in your
current browser.
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Colorfront Web Viewer for stream sessions

5.3.3. Easy Join

As an alternative to connecting to a stream via Email Invites or invite URLs, Easy Join provides a simplified
way to joining sessions. Instead of logging in or entering an email, viewers use a short numeric code
included in their session invitation. This reduces the number of steps required to access a stream,
particularly on mobile devices, but it is less secure than the standard authentication method.


Easy Join bypasses default security features that protect streamed content. It should only
be enabled with a clear understanding of the associated risks.

Easy Join codes are numeric only. Their length can be set in Team Preferences with the Easy Join code
length option. Available lengths are: [6], [8], [10], [12], [14], and [16].

Codes are generated automatically in the Stream Manager when a session starts, provided that Easy Join
has been enabled at the team or route level. The host can then share the code with viewers directly.

Team Managers control Easy Join settings in the Team Manager Menu:

• In Team Preferences view, Easy Join can be enabled for all team members. When activated, team
members receive an email notification. For sessions where Easy Join is available, invitations also
include an option for the host to disable it. If a host wishes to restore default security protections, they
can do so by following the link in the notification email.
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• In Streaming Servers view, Easy Join can be enabled for all users of a given Streaming Server.

5.4. Managing Viewers
When a user connects to the stream, a green icon appears next to the viewer’s name. Used invitations are
marked with a yellow checkbox. Each viewer entry also shows stream quality (green icon), location,
connected device(s), and date and time of connection.
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Click [Save viewer list] to store the current session’s viewers for later use. See Email Invites for details.

Stream viewers list

At the end of each viewer entry, three action buttons are available:

Add viewer with code Enter the six-character access code from another of your devices to join the
stream. The code is generated by clicking the Play button in the Streaming
Player app on an Apple device (iPad, iPhone, Apple TV) or on the desktop
application for macOS or Windows.
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Device info Click to display details about the user’s active device(s). The metadata shown
is provided to the Stream Manager by the Streaming Player application. This
panel also includes heartbeat data with real-time updates on the device’s
connectivity and operational status.

Remove viewer Click to remove the viewer from the list of active viewers.

5.5. Monitoring Streams
The Stream Manager is not only a powerful interface for managing stream sessions, it also provides real-
time monitoring of stream parameters for connected clients.

The stream’s health can be checked by clicking the info button, which opens the Channel Details panel.
Here you can view live stream parameters such as address, port, bitrate, and packet loss rate for both the
streaming source and the selected viewer. If multiple viewers are connected, you can switch between
them using the small arrow.

Info button to open channel details
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Channel details panel

The source panel and the viewer panel each include one graph icon. Clicking the icon opens a statistics
view with selectable graphs.

In the graph panel, a drop-down menu allows you to select from the following metrics:

• Bitrate

• RRT

• Packet Loss Rate

• Retransmitted Packets

For viewer panels, an additional option is available:

• Summarized Bitrate
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Streaming channel details with graphs

5.6. Team Manager Privileges
Team Managers (TMs) are users with higher privileges than regular Stream Manager users. In addition to
the Streams Page, Team Managers have access to two further menu options in the top navigation:

• Team Manager Menu for managing team preferences, members, and streaming servers.

• Logs Menu for logging and monitoring user activity and connection characteristics

5.6.1. Team Manager Menu

The Team Manager menu provides access to configuration and management options that are not available
to regular users. In addition to being able to send invitations, Team Managers (TMs) have elevated
permissions in three areas, accessible from the drop-down menu:

• Team Preferences: Configure team-wide settings such as invitation expiry, email template branding,
login persistence, and watermarking options.

• Team Members: Manage team membership by adding or removing users, resetting passwords, and
editing member details.

• Streaming Servers: View and manage registered streaming servers, including version information,
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configuration, and connection status.

Team Manager menu

Team Preferences

In the Team Preferences view, Team Managers can configure various team settings. Configurable
parameters are:

Team Preferences view

Team name Define or update the team’s display name.

Invitation expires in Set the validity period for invitation links. Options: [5m], [10m],
[30m], [1h], [No expire].

Invitation usage limit Limit how many times an invitation link can be used. Options: [2],
[5], [10], [50], [100], [Infinity].
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Contact email address Example: user@domain.com, Support
<support@domain.com>.

Contact phone numbers Example: 1-541-754-3010, Support <+1-541-754-3010>.

Send invites from StS When enabled, streaming servers are allowed to send invitations.
If disabled, streaming servers will not be permitted to send
invitations.

Force MFA Require all team members to enable multi-factor authentication.
Enabling this will also enforce MFA on your own account.

Login persistence Choose whether members stay logged in or are logged out after
closing the browser.

Visible watermarking Enable or disable visible watermarks on streams.

Device code flow without auth Allow device code–based login without authentication.
If disabled, streaming players must authenticate (using default
passwordless login) before they can use the device code flow.

Auto approve activation requests When enabled, all activation requests are automatically approved.
If disabled, requests must be approved manually.

Force StP Authentication All viewers must log in and authenticate before joining a session.
If a custom identity provider is configured, viewers authenticate
through that provider.

 Cannot be used together with Easy Join.

Allow Easy Join Allow users to join sessions without authentication using an Easy
Join code. Security implications should be considered. For more
information, see Easy Join.

• Disabled: Easy Join is disabled for all team channels.

• Enabled: Easy Join is enabled for all channels, though
individual channels can be opted out.


Cannot be used while Force StP
Authentication is enabled.

Easy Join code length Define the number of characters in Easy Join codes. Options: [6],
[8], [10], [12], [14], [16].

Identity provider Select authentication provider. Options: [Custom],
[Passwordless], [Team Member].
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Custom Identity Provider • Issuer URL: URL of the OpenID Connect discovery document.

• Client ID: Value obtained from the OIDC provider. Consult
your provider’s documentation.

• Callback URL: Must be registered with the OIDC Issuer. Use
the following callback URLs:
https://device.colorfront.cloud.com.colorfron
t.StreamingPlayer
https://colorfront.auth0.com/macos/
com.colorfront.StreamingPlayer/callback

Realtime pointer Allow viewers to interact with pointers in their Streaming Players.
By default, all channels are enabled unless specific channels are
disabled.

• [Enabled]: Pointers active on all team channels.

• [Disabled]: Pointers are disabled for all team channels.

• [Per Channel setting]: Pointers can be enabled or disabled for
each channel separately.

Remote control Allow viewers to remote-control the server via their Streaming
Players. By default, all channels are enabled unless specific
channels are disabled.

• [Enabled]: Remote control active on all channels.

• [Disabled]: Remote control disabled for all team channels.

• [Per Channel setting]: Remote control can be enabled or
disabled for each channel separately.

Voice conference Allow viewers to communicate through voice conferencing in
their Streaming Players. By default, all channels are enabled
unless specific channels are disabled.

• [Enabled]: Voice conference active on all channels.

• [Disabled]: Voice conference disabled for all team channels.

• [Per Channel setting]: Conferences can be enabled or
disabled for each channel separately.

Email template logo Upload or delete the logo displayed in invitation emails.

Team Members

The Team Members page lists all users in the team, showing their email address and whether they are
Team Managers (TMs).
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Team Members page in Stream Manager

You can perform the following actions here:
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Add new members 1. Click [Add new member] to open the panel on the right.

2. Enter the user’s name and email address, and configure their
Manager role and channel access.

3. Choose between All channel access or Per-channel access by
selecting specific channels from the menu.

4. When finished, click [Create].

5. The new user will receive an email invitation to join the team and
set their password.
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Edit team members Click a user entry to open the edit panel on the right. Here you can
rename the user, enable or disable the Manager role, and set channel
access.

Editing team members

• To rename a user, edit the displayed name. The change is applied
immediately.

• To grant or revoke TM rights, toggle the Manager checkbox.

• To suspend a member, enable Suspended in their edit panel.
Suspended users lose all permissions and are hidden from the list
by default. To re-activate, enable Show suspended in the top bar,
select the user, and clear the Suspended option in the edit panel.


Team Managers cannot be suspended directly.
Their Manager role must be revoked first.

Reset password / Delete user In the user’s edit panel, open the three-dot menu in the top-right
corner to reset the user’s password or delete the user from the team.

Streaming Servers

The Streaming Servers page lists registered servers by ID and name. Connection status is shown with
colored icons, such as a green checkmark for connected status or a dark yellow triangle for servers that
have not logged into the Stream Manager in the last 24 hours.

 Hover over the icons to see the tooltip.

Each entry also displays the server’s application version. Orange indicates a version below the
recommended level, and red indicates a version below the minimum requirement.
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Click a server entry to open the Edit panel on the right. Here you can rename the streaming server or its
channels individually, and generate a passkey.

Streaming Servers page

Additionally, the following options are available:

Visible Watermarking Enable, disable, or set Company default to display a watermark in players per
channel. Users joining the team session for that channel will see
watermarked text if enabled. The watermark contains the invited user’s email
address and a random string that identifies the user (searchable in activity
logs).

Allow Easy Join Enable this option for all users of the selected streaming server. See Easy Join
for details.

Allow Remote Control Allow remote control of the streaming server via connected Streaming Player
applications.

Allow Pointer Enable pointer sharing between viewers in a session. Each viewer is assigned
a distinct color, making it easy to reference areas of the footage on screen.
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Edit panel for a streaming server

5.6.2. Logs Menu

The Logs menu provides access to detailed histories of sessions, activity events, and authentication
records for the team. Use the drop-down menu at the top to switch between:

• Session History

• Activity Logs

• Auth Logs

Logs menu in Stream Manager

Session History

The Session History view (default) lists both active and expired sessions for the selected team. Each entry
shows key information, including number of viewers, session start date and time, and total duration.
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Session history log

Clicking a session opens a detailed view with the following sections:

Session timeline A chronological list of events from session start to end. Each entry is clickable and
opens the related activity log.

Viewer summary Lists the email addresses of connected viewers and highlights invitees who did not
connect.

Logs Displays all activity logs generated during the session. Clicking a row opens a
details panel on the right.

Log entries can be filtered by viewer email, date, IP address, or message. Start
typing in a field to apply filters.
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Session detailed history

Activity Logs

The Activity Logs view lists all log entries for the current session. You can filter entries by parameters such
as Company, Session UUID, watermarking ID, team, or date. After setting filters, click [Get logs] to display
the results.

Double-clicking an entry opens a panel on the right with detailed information for that log.

Activity logs
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Auth Logs

The Auth Logs view displays records of all login attempts to the Stream Manager. Entries can be filtered
by month or other parameters using the Filter field. After setting filters, click [Get logs] to display the
results.

Auth Log view
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6. Stream Setup
When using the standalone Streaming Server appliance, the operator can stream from the video output of
any third-party editing, grading or finishing system. Color metadata, including Dolby Vision metadata, is
automatically extracted from the input signal and channeled to the client application. The powerful
Colorfront engine of the Streaming Server unit can handle four independent sources and the
corresponding stream targets.

6.1. Source Channel Configuration
The Channels menu is used for mapping SDI, NDI and CDI input sources to the four streaming channels.

With the Channels › Channel 1/2/3/4 › Input › SDI 1/2/3/4 menu items you can connect any SDI input
source to any channel.


The same input source can be connected to multiple channels in order to generate
simultaneous streams with different resolution, quality or color settings.

NDI (Network Device Interface) is a standard protocol for ultra-low latency, premium quality video
encoding and video transmission over the IP network. Streaming Server allows you to connect multiple
channels of NDI sources to the streaming channels over your local area (LAN) network.



AVID Media Composer’s NDI audio uses 20 dB of headroom by default. Since no related
metadata travels in the NDI signal, Streaming Server will automatically compensate for
this if the NDI feed’s name ends with .AVID.

Alternatively, you can configure all NDI inputs for a specific reference level using the
following Startup.xml key:

<NDIInputReferenceLevel type="int">20</NDIInputReferenceLevel>

Use the Channels › Channel 1/2/3/4 › Input › NDI menu option to select NDI as the source for the

streaming channel. NDI feeds can be changed dynamically by using the Channels › Channel 1/2/3/4 ›
Input › NDI Inputs options for available NDI sources.

Assigning input source to channel

AWS’s CDI (Cloud Digital Interface) is a reliable low-latency networking technology that allows
transporting uncompressed video in real time between applications and services inside the AWS cloud,
using EFA (Elastic Fabric Adapter) enabled Amazon EC2 instances.

To set up a CDI input, follow these steps:

1. First, switch to the CDI Settings and verify that the CDI Adapter IP of the EFA adapter is 127.0.0.1
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
If you have multiple EFAs in the system, you must specify the exact IP address of the
EFA adapter you want to use.

2. In the CDI Port / Input A/B/C/D settings, enter the port numbers you are using for the CDI sources
coming into the Streaming Server. Default port numbers are: 2000, 2001, 2002 and 2003

3. Finally, select the appropriate CDI source using the Channels › Channel 1/2/3/4 › Input › CDI Inputs
menu items.

Setting CDI inputs

The Channels › Channel 1/2/3/4 › Stream › Start/Stop menu options are for initiating/stopping the
stream of the selected channel.

6.2. Stream Channel Configuration
Streaming Server is a four-channel device where each streaming channel can be configured
independently. The operator can configure the input source, stream quality, resolution and color
conversion parameters.

Simultaneous streams in the Streaming Server
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To configure streaming in Streaming Server through an output channel, hit the [Tab] button to get to the
Settings Page. There are separate sections for each streaming channels such as STREAMING CH1 or
STREAMING CH3:

• Resolution: Select from various resolutions for the stream, such as HD, UHD or 4K. The system will
resize the video stream on the fly. Streaming Server also supports streaming 720p resolution video or
transmitting it to the video output.

 In case of 720p video source, set the Resolution to [SameAsSource].

• Bitrate: Enter low bitrate (5 Mbit) for lower resolution SDR output, e.g. for streaming on iPhone, or
higher bitrate (20 Mbit) for UHD HDR streams, e.g. for the grading room.



When using the Stream Manager, the maximum bitrate is limited by default to keep data
traffic at a reasonable rate. If you set a bitrate exceeding this limit, a warning message will
be displayed. (If this limit is not sufficient and you would like to stream at higher bitrates,
please Contact Customer Support.)

• Input/Output Color Space: Set the color space of the input or output signal, such as [HD709],
[HDR10] or [P3DCIGamma26]. For Input, [Auto] means that the color space follows the source
metadata. In case of Output, [Auto] follows the current setting of the input color space.

• Video Chroma Format: In the Advanced Streaming Channel 1-4 Settings, configure the chroma
sampling of the video transmission . [4:2:0] will be more optimal for low or moderate data rates, while
[4:4:4] is to be used for premium quality.

Depending on the current network architecture (Stream Manager/direct streaming), the operator may
also set connection parameters such as the passphrase. This is not necessary when streaming using
Colorfront’s Stream Manager. See Network Configuration for more information.

After setting the most important parameters on the Settings Page, go back to the main view, and start the

streaming of any input channel by using the Channels › Channel 1/2/3/4 › Stream › Start menu option.

To stop the stream, use the … › Stop option.
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
In quadrant view, the Streaming Status Connected Clients parameter will show how many
clients are currently connected to the stream via Colorfront’s Streaming Player
application. Both the number of clients and their IP address will be displayed.

Streaming Server supports streaming embedded Dolby Vision metadata over SDI.

6.2.1. P2P Streaming Configuration

When streaming directly, whether with or without the Stream Manager, the remote stream may not use
the correct IP address when generating the client invitation link. This issue can occur if the server has
multiple network interface cards or the stream passes through a network device, causing the server’s local
IP address to change. In such cases, navigate to the Network Settings and manually enter your public IP
address in the Shared IP for Direct Stream setting. This ensures that the generated invitation link
contains the correct IP address, allowing the viewer to access the stream effectively.

To configure your Streaming Server for P2P streaming, follow these steps:

1. Access settings. Press Tab to enter the Settings Page, and then select the desired Stream Channel (1-
4) that you want to configure for P2P streaming.

2. Set your preferred Resolution , Color Space, and Bitrate. We recommend the following
configurations based on your resolution:

◦ [HD]: 5-10Mbps

◦ [2K]: 10-20Mbps

◦ [UHD] or [4K]: 20-40Mbps

3. Configure Port. The default UDP ports are as follows; however, you may customize these ports based
on your network requirements.

◦ Stream Channel #1: 8888

◦ Stream Channel #2: 8889

◦ Stream Channel #3: 8890

◦ Stream Channel #4: 8891

4. Select Connection Type. Set this to [Listener] mode for P2P streaming. This configuration allows
Streaming Server to listen for incoming connections from the Streaming Player application.

5. Set encryption passphrase (Optional). If you want to secure your stream, manually enter an
Encryption Passphrase. We recommend a minimum of 10 characters for AES-256 encryption. If
encryption is not needed, leave this field blank. The Streaming Player will not require a passphrase to
connect.

6. Configure watermarking (Optional). If you wish to include a Visible Watermark on your stream, set
the desired transparency level. A lower transparency value will make the watermark more prominent.
If no watermark is needed, leave this field blank.

7. Finalize configuration. Press Tab to exit the settings and save your configurations.

Refer to the Streaming Player manual to complete the connection to your stream.
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P2P streaming configuration

P2P Streaming via the Stream Manager

The most secure and convenient way of direct streaming (P2P) is through the Stream Manager. In this
setup, the stream is locally available, and invitations to streaming sessions are sent through the Stream
Manager. If you prefer this option, follow these steps:

1. Navigate to the Stream Manager Settings and activate the following settings:

◦ Use Stream Manager

◦ Manage SRT Gateway

◦ P2P Streaming With Manager

2. Next, follow the steps in P2P Streaming Configuration.

6.2.2. Different Streams From Same Input Signal

Streaming Server has the ability to generate different types of streams from the same input video signal.
This powerful feature makes it possible to adapt to various bandwidth, quality, color space or security
requirements at the same time from the same Streaming Server system.

One possible use case for transferring different quality streams concurrently is sending:

• a high-quality UHD HDR 4:4:4, 10-bit, 30 Mbit stream to a high-end grading monitor for critical review,
and

• an HD SDR 4:2:0, 5 Mbit low bitrate stream to the producer’s iPhone.
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Simultaneous stream of UHD Dolby Vision HDR and HD SDR footage

Additionally, the Stream Waveform parameter within the Advanced Streaming Channel 1-4 Settings
allows for further customization. When enabled, you can send the waveform of the image in the stream
instead of the actual image, making it useful for technical reviews.

6.3. Secondary Stream
The Streaming Server supports secondary streaming using either WebRTC, an open-source video
transport protocol designed for low-latency, real-time video, audio and data transmission, or an external
gateway. This feature complements the primary stream by offering an alternative viewing option with
potentially lower latency, ideal for real-time applications.

To enable this feature, navigate to Advanced Settings and activate the Secondary Stream parameter.
Select either [WebRTC] (default) or [Gateway] as the Secondary Stream Target.

After enabling the secondary stream and initiating it via the Streaming Server, you can launch the stream
through the Stream Manager. Simply click the "Join session" icon next to the Invite button. In the
subsequent window, select the [Join] button to view the stream in a web browser. This will open a separate
window where the video, streamed as H.264 8-bit HD 4.2.0 format SDR, begins playing.
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Join session icon in the Stream Manager

Click to join the WebRTC stream

Alternatively, you can connect to the stream through an email invitation. Click the [Join with browser]
button in the email to view the law-latency stream in a separate browser window.

Click to join the WebRTC stream


If you have the Streaming Player application installed, you can click [Join Session] to
access a high-quality version of the stream via the software.

6.4. Network Configuration
You can initiate streaming with Streaming Server as follows:
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Streaming via Stream Manager After you specify the parameters in the Stream Manager Settings
for the Stream Manager, the system automatically populates the
stream parameters, such as Address, Port and Passphrase of the
available streaming channels. See the Stream Manager
Configuration section on how to set up Colorfront' Stream
Manager.

Streaming directly (P2P) For point-to-point streaming, set the necessary settings such as
Address, Port and Encryption Passphrase of each streaming
channel. The default port numbers are:

• 8888 for channel 1

• 8889 for channel 2

• 8890 for channel 3

• 8891 for channel 4

Essential settings for P2P streaming

For information on the different components of each streaming modes, see Streaming Network
Architectures.

6.4.1. Stream Manager Configuration

To access the Stream Manager for the Streaming Server, simply navigate to it from the menu by selecting

Stream › Go to Stream Manager.

To initiate streaming with the Streaming Server, please follow the steps below:

1. Go to the Stream Manager Settings, and enable the Manage SRT Gateway and the Use Stream
Manager options.

2. Enter stream-api.colorfront.cloud as the Stream Manager Address.

3. Add your login information to the SRT Gateway User and Stream Manager Password fields.

4. Optionally, specify a temporary license for the Streaming Player in the Streaming Player License field
for the stream viewers if they do not have one. In this case, the stream recipients need to have the
Streaming Player application installed on their computer to see the stream.
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Configuring Stream Manager parameters in the Stream Manager settings

5. After defining the above parameters, Streaming Server and the Stream Manager API create a
handshake, and the streaming parameters for available streaming channels in the Streaming Channel
1-4 Settings are automatically populated, such as Address, Port and Encryption Passphrase.

6. Make sure that the Connection Type is set on [Caller] for each streaming channel.

7. You can configure additional parameters such as Resolution or Bitrate in the Advanced Streaming
Channel 1-4 Settings.

8. Go back to the main view and start the stream session either using the Channels › Channel 1/2/3/4 ›
Stream › Start menu option, or clicking the [START STREAM] button.

The Start/Stop Stream buttons are only available in Streaming Status view. See Quadrant Views for
details.

Starting the stream for Channel 2; Channel 1 is already streaming
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6.4.2. Network Setup

The NETWORK section on the Settings Page offers a convenient interface to review and, if needed, adjust
the network configuration of the system. The same network adapter parameters are also available
through the standard Windows OS Control Panel. In this page, you can view and change the IP address of
the unit in particular. By default, the DHCP is enabled, so you should see a relevant IP address.

Network settings on the Settings Page

6.5. Custom LUT on Stream
Color conversion for the stream is possible without using the Streaming Server’s own color space
conversion, only using custom LUTs. To apply a custom LUT for color conversion on the streamed image,
please follow these steps:

1. Name your custom LUTs as follows: STREAMLUT1.3dmesh, STREAMLUT2.3dmesh, etc.

2. Save your custom LUTs in the \Program Files\ColorfrontPlatform\lut folder.

3. Go to the Advanced Streaming Channel 1-4 Settings and enable the Custom Input LUT parameter.

4. The LUTs will be applied on the displayed and streamed image. You can either [Bypass] the Streaming
Server’s Input Color Space conversion in the Streaming Channel 1-4 Settings, or optionally set it to any
conversion option, which will be implemented after the custom LUT is applied.

6.6. URL Links for Streaming Player
There are several ways to watch the stream via the Streaming Player application:
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Send email invites from Stream Manager On the Routes page of the Stream Manager, the
Invite button allows you to add email addresses to
invite potential viewers to the selected streaming
channel.

Create invite URLs in Stream Manager You can use the play button next to the name of the
selected streaming channel to generate invite URLs
from the Stream Manager’s Routes page.

See Inviting Viewers to learn how to invite people via
the Stream Manager to view the stream.

Send invites from the Streaming Server menu See Sending Stream Invitations From Menu for
details.

Generate URLs directly from the menu See the next section for details on creating invite
URLs directly from the Streaming Server’s menu.


To be able to view the stream, the Streaming Player must be installed on the viewer’s
computer.

6.6.1. Sending Stream Invitations From Menu

The Streaming Server allows you to send invitations to stream sessions directly from the menu. Simply

select the Channels › Channel 1/2/3/4 › Stream › Send Email Invitation(s) and enter the recipient email
address(es) in the pop-up window.

To invite multiple viewers, separate email addresses using commas (,) or semicolons (;), with or without
spaces.

Inviting stream viewers from the Streaming Server’s menu

Adding email addresses in the pop-up window
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6.6.2. Invite Links From Menu

The Streaming Server has the ability to publish invite links, which are clickable URLs that automatically
open the Streaming Player application and launch streaming. To generate invite URL links from the
Streaming Server’s menu, please follow the steps below:

1. Go to the Channels › Channel 1/2/3/4 › Stream menu option, and Start the stream if it is not running
yet.

2. Use the Channels › Channel 1/2/3/4 › Stream › Get Link (P2P) menu command to copy the URL to a
clipboard.

3. Paste the URL into an email or any communication message. When the recipient of the message clicks
on the URL, the Streaming Player, if installed, will open automatically and the stream will start (output
stream).

4. Alternatively, if the Streaming Player is installed on your computer, enter the link to the address bar of
your browser and start watching the stream.

6.7. Third-Party Configuration for SDI Audio Streaming
For proper audio playback when streaming via SDI with Streaming Server, the following configurations
must be applied in the settings of third-party applications.

Streaming From DaVinci Resolve

In order for Streaming Server to properly receive the audio stream via SDI from the DaVinci Resolve
application, open Preferences, and enable the Mirror audio I/O engine output option on the Video and
Audio I/O tab.
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Configuring DaVinci Resolve preferences for streaming via Streaming Server

Streaming From Adobe Premiere

First check if the AJA/Blackmagic Design card is visible on the Playback tab of Preferences. If not,
uninstall the AJA/Blackmagic Design device using the device’s uninstaller in the Applications, and then
install it again.

Next, make sure that the AJA/Blackmagic Design card is set for both Audio Device and Video Device,
and uncheck this option: Disable video output when in the background.

Configuring Premiere Preferences
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7. Web Control Interface
For easy configuration without having to access the physical unit, the Streaming Server can also be
controlled via Colorfront’s Web Control interface in a web browser at the following address:
<IP address>/cf-web-control or localhost/cf-web-control

This interface includes the complete set of controls, including user management, role assignment, input
selection, stream configuration and real-time status information.

You can enter the Web Control site with a default admin user with the following credentials:

• username: admin

• password: Admin123

 For security reasons, please immediately change the default password after the first login.

First, go to the Connection page, and connect to the selected server.

Connecting to the Web Control Interface

The Colorfront Web Control consists of the following pages:
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Admin • User Manager: Create new users, edit user profiles or assign admin or other roles
to users.

• Roles: View details for each role type, delete or modify roles, or set up new roles.
You can add authentication to system configuration and list or edit roles and user
profiles.

 Only admin users are authorized to add or configure roles.

• Roles assignment: View the list of roles and use filters to search between them.

Web Control • Connection: Select the server and establish a connection to use the Web Control
functions.

• Menu: Configure input channels and start/stop streaming. You can also configure
each video input with different resolution, color space, transport mode or pixel
mapping parameters.
[Start Stream Logging] here if needed.

• Settings: Configure streaming channels individually with different resolution,
bitrate, input/output color space and other parameters.
Click Show advanced to view additional configurable options.

• Logs: Monitor streaming and view basic stream information for each channel.

• Info: Check the status of your the streaming channel, including information such as
packet loss rate, bandwidth, encryption state or connected clients, as well as frame
drop count and Dolby Vision metadata.
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Colorfront Web Control interface for Streaming Server
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8. Streaming Server Within AWS
To set up the Streaming Server with CDI/NDI support within the AWS infrastructure, please provide the
following information to Colorfront:

• AWS 12-digit account ID

• AWS region in which you want to deploy the AMI


Do not use the AWS account root user for any deployment or operations of the Streaming
Server in the Cloud.

Once Colorfront receives this information, we will share the AMI in the requested region and email you the
AMI ID number for configuration.

8.1. Requirements for AWS Deployment
Before configuring Streaming Server within AWS, make sure you have the necessary resources and
configurations in place:

8.1.1. Deployment Time

The deployment time may vary based on your team’s familiarity with AWS and the complexity of your
infrastructure. Ideally, the system can be deployed and tested in optimal environments within 24-48
hours.

8.1.2. Region Support

The virtual Streaming Server is supported in any region that supports the required instance type. It can be
deployed in Single or Multiple Availability Zones.

8.1.3. Instance Type

• Supported instance types include g4dn-8x-large, g5-8x-large or g6-8x-large.

• Elastic Fabric Adapter (EFA) is required for CDI.

• Windows 2019/2022 Server OS is required.

8.1.4. Disk Requirement

If not using Colorfront-provided AMI, a 64 GB system disk is required.

8.1.5. IAM Role

The end user’s security team can set up the necessary permissions for managing the system.

8.1.6. IMDSv2 Support

IMDSv2 is supported for enhanced security measures within the setup. You have the option to disable
Instance Metadata Services Version 1 for improved security and protection against potential
vulnerabilities.
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8.1.7. Security Groups

Security groups must allow all traffic on the same subnet as the streaming server and source of the CDI.
This is a requirement for CDI and NDI.

8.1.8. Elastic IP

Assigning an Elastic IP address to the system is optional.

8.1.9. Licensing

POC license Contact support@colorfront.com or your Colorfront representative to obtain a POC
License.

Yearly license Purchase a Colorfront Streaming Server subscription from your authorized Colorfront
Reseller. For the worldwide network of resellers, refer to the Colorfront Resellers
website.

License server Once the license is obtained, the system initiates an activation process when the
software launches by contacting the license server hosted at My.nalpeiron.com. The
following ports are utilized for communication:

• Port 80 TCP (HTTP): 184.106.60.185 and 20.237.110.18

• Port 443 TCP (HTTPS): 184.106.60.185 and 20.237.110.18



The IP address for licensing has not changed in the past nor do
we expect it to change in the future. However, unexpected
situations do occur. If at all possible, it is recommended that you
use the domain name (my.nalpeiron.com) rather than the IP
address. This will ensure that licensing will connect to the
Nalpeiron server even if the IP address is changed.

8.1.10. Colorfront Stream Manager

Refer to the Stream Manager section for detailed requirements and setup instructions.

8.1.11. Latest Software Builds

Sign up here for the Colorfront Newsletter and notifications at Colorfront’s Support page to receive
automated notifications when new builds are released.

8.2. Create EC2 Instance in AWS
An EC2 (Elastic Compute Cloud) instance is a virtual server in Amazon AWS. To set up an EC2 instance
with the Amazon Machine Image (AMI) you have received from Colorfront, please follow these steps:

1. Log into the Amazon AWS console at https://aws.amazon.com/ and open the EC2 (Elastic Compute
Cloud) dashboard.

2. Make sure the appropriate region and availability zone is selected at the top right corner of the page,
such as the us-east-1 availability zone for the US East North Virginia region.
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
Opt for the AWS region that is closest to the location of your customer base to reduce
network latency for users.

Selecting the adequate availability zone

3. In the left navigation pane, choose AMIs.

Go to AMIs on EC2 Dashboard

4. In the Search bar, type the first few letters of the AMI name you received from Colorfront.

5. Select your AMI from the list and right-click on it.

6. In the popup menu, select Launch Instance from AMI. You can also initiate this using the top orange
button.
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Launching instance from AMI with right-click

Launching instance from AMI with button

7. Next, the launch instance wizard will open, where you can enter all necessary configurations. First, in
the Summary panel on the right, add the number of instances you want to launch.

Entering number of instances to launch

8. Under Name and tags, enter a Name for your instance.

Adding name of instance

9. Under Application and OS Images (Amazon Machine Image), the Colorfront AMI has already been
selected from the catalog for your instance, but you can also Browse more AMIs.

10. Under Instance type, select a G5 instance suitable for your environment. The recommended
configuration is g5.12xlarge with four NVIDIA A10G Tensor Core GPUs. If no G5 instances are available,
select g4dn.12xlarge with four NVIDIA T4 GPUs.

11. Under Key pair (login), select your already existing keys, or click Create new key pair to generate a
.pem file on your local computer. This public-private key pair allows you to securely connect to your
instance. While the public key is stored by AWS, you should store the private key in a secure directory
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on your computer.


Your private key should be kept safe and secure. Make a note of where it has been
downloaded to your computer.

Creating key pair

12. Set the password for the instance to ColorfrontStreamCDI2023

13. Under Network settings, select the desired VPC and subnet with the appropriate Availability Zone.
Click [Edit] to make changes.

a. Make sure that the instance is in the same VPC/AZ and Subnet as the CDI Source System.

b. Additionally, enable Auto-assign public IP so that AWS can assign a public IP address to your
instance. You can also assign an elastic IP address for easy configuration.

14. For Security Group, use an already existing group or create one by adding a name and description.

a. For the source type of the below security group rules, select either:

i. Anywhere - Your instance is accessible from any location.

ii. My IP - Specify your current IP address.

iii. Custom - Enter any CIDR blocks (separated by commas) or block range(s).

b. Specify the following inbound security group rules:

rdp The default rdp type TCP protocol at port 3389 is for the Microsoft Remote
Desktop.

HTTPs Specify a HTTPS type TCP protocol on port 443 for secure internet traffic to
access the Colorfront Web Control interface of the Streaming Server.

custom TCP 1 Define a custom TCP protocol for port 1973 so that you can remote control
your instance with the REST API interface.

custom TCP 2 Specify another TCP protocol for port 8443 for remote controlling your
instance through Amazon’s NICE DVC client application.

66



Custom UDP This should be updated once you have assigned the UDP port on which the
streaming traffic will flow between Streaming Server and the Colorfront
Stream Manager system.

ALL Traffic Must allow all inbound and outbound subnet traffic for CDI traffic to flow
between machines.

Inbound security group rules

c. License Requirements - need Inbound/Outbound to the following:

i. my.nalpeiron.com

ii. port 80 TCP (HTTP) 184.106.60.185

iii. port 443 TCP (HTTPS) 184.106.60.185



The IP address for licensing has not changed in the past nor do we expect it to
change in the future. However, unexpected situations do occur. If possible, it is
recommended that you use the domain name (my.nalpeiron.com) rather than
the IP address to ensure that licensing will connect to the Nalpeiron server even
if the IP address changes.

15. For Advanced Network Configuration, under Network Interface 1:

a. for Description add a name such as Colorfront STS EFA.

b. Additionally, make sure Elastic Fabric Adapter is enabled.
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16. Under Configure storage, increase the gp3 root volume to 128 GiB to provide adequate storage space.
You can add additional volumes later if needed.

 Make sure you select an SSD type for the root volume.

Increase root volume to 128 GiB

17. In the Advanced details section, the following configurations may be required:

◦ IAM instance profile - In addition to traffic control by security groups, additional limitations can be
defined here that control access to the instance in terms of users or services. For example, you can
assign an S3-full-access permission policy role to the instance through an additional profile.

◦ It is important to enable Termination protection so that you do not accidentally delete your
instance.

◦ Optionally, you can enable Detailed CloudWatch monitoring to be able to monitor, collect and
analyze metrics about your instance.

18. Click [Launch instance] to launch your Amazon EC2 instance.
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◦ Once it is launched, the default password is: ColorfrontStreamCDI2023

◦ You can log in with RDP or NiceDCV.

19. Once you are launched and have Streaming Server running:

◦ Please send Colorfront the instance ID. We use this to add the system to the Colorfront Stream
Manager.

◦ If you currently do not have access to the Stream Manager interface, we will create a team and user
profile for you, providing the required permissions.

8.3. Setting Up the System
When using the Streaming Server software, operators can stream from the video output of any third-party
editing, grading, or finishing system that supports CDI or NDI. Color metadata, including Dolby Vision
metadata, is automatically extracted from the input signal and transmitted to the client application.

8.3.1. Licensing the Colorfront Streaming Server

Once the system is launched and the Instance ID is added to the Colorfront Stream Manager:

1. You will receive a license file for the system named sts.txt.

2. Save this license file in the directory C:\ProgramFiles\ColorfrontPlatform\License.

3. Proceed to launch the Streaming Server.

8.3.2. Configuring Nvidia Driver Settings

To optimize performance and ensure compatibility with your system, adjust the following settings within
the Nvidia Control Panel:

1. Open the Nvidia Control Panel app.

2. Under 3D Settings, click Manage 3D settings.

◦ In the Global Settings tab, for Global presets, select [Base profile].
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▪ Then, within the Settings list, set CUDA - GPUs to [All].

▪ Optionally, set the Multi-display/mixed-GPU acceleration to [Single display performance
mode].

▪ Set the OpenGL rendering GPU to one of the NVIDIA cards to which the display monitor is
connected.

▪ For Power management mode, make sure [Prefer maximum performance] is selected.

▪ Set Vertical Sync, select [Use the 3D application setting].

3. Under 3D Settings, click Set PhysX Configuration.

◦ Under PhysX settings, set the Processor to [CPU].

8.3.3. XAMPP Configuration

Make sure that Apache and MySQL are running as services and started.

8.3.4. NDI Access Manager

In the NDI Access Manager, configure the internal IP Address of the NDI input that serves as the source.
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Setting the IP address in NDI Access Manager

8.3.5. Streaming Server Configuration

After launching the Streaming Server software, the first step is to configure the SRT Gateway settings to
authenticate your Streaming Server to the Colorfront Stream Manager system.

Press the [Tab] key on your keyboard to bring up the Settings Page, and then navigate to the Stream
Manager Settings section.

Stream Manager Setup

Please confirm the following steps are completed:

Manage SRT Gateway Make that this option is toggled [On].

Use Stream Manager Verify that this option is also enabled.

Stream Manager User Leave this field blank as it is not required.

Stream Manager Address Set it to stream.colorfront.cloud.
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Stream Manager Password Follow the steps below to set the password:

• Go to the Stream Manager website.

• Log in using your username and password.

• Navigate to the Team Manager page.

• Select the Streaming Servers tab.

• Click on the small edit button at the end of the server row.

• Hit the [Generate password] button.

• Copy the generated code.

• Return to the Streaming Server’s Settings Page, to the Stream
Manager Settings, and paste the code into the Stream Manager
Password field.


You only need to complete this process once, and
the system you are streaming from will be
authenticated to the Stream Manager.

CDI Section

1. Switch to the CDI Settings section of the Streaming Server’s Settings.

2. Verify that the CDI Adapter IP for the EFA adapter is set to 127.0.0.1.


If multiple EFAs are present in the system, specify the exact IP address of the EFA
adapter you intend to use.

3. For the CDI Port/Input A/B/C/D parameter, enter the port numbers corresponding to the CDI
sources incoming into the Streaming Server.

Default port numbers are: 2000, 2001, 2002, 2003

Selecting Streaming Server Input Channel

Finally, you need to select the CDI input of the streaming channel you want to use within the Channels ›
Channel 1/2/3/4 › Input › CDI Inputs menu items.

Setting the CDI input
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8.3.6. Streaming Gateway Access

Here, you will find all the necessary information to access Colorfront Streaming Services. It is essential to
note that all required connections are outbound. By default, there is no need to enable inbound
connections unless specifically required by your networking team.

Streaming Gateway Access [US]

Only an outbound UDP connection is required. The ports may vary between StS instances but remain
constant even if the gateway changes. For US customers, the possible host/IP addresses are as follows:

sakura-la1.colorfront.cloud UDP (84.17.45.139)

sakura-la2.colorfront.cloud UDP (84.17.45.155)

sakura-lax.colorfront.cloud UDP (52.53.48.52)


In the event that both DP servers are unavailable, the sakura-lax host serves as the final
solution. This address is a preallocated elastic IP. Additionally, in the event of a disaster,
we have the capability to set up an ad-hoc gateway in EC2.

Streaming Gateway Access [EU]

sakura-frankfurt1.colorfront.cloud UDP (45.136.153.208)

sakura-frankfurtx.colorfront.cloud UDP (Not allocated yet)

Streaming gateway access [AU]

sakura-alpha-apau.colorfront.cloud UDP (EC2 auto assigned IP address)

Streaming gateway access [JP]

sakura-jpn1.colorfront.cloud UDP (EC2 auto assigned IP address)

Stream Manager API access [All region]

brokerapi-test.colorfront.cloud 443/TCP (the IP address could be any of AWS’s CloudFront address
space)

stream-api.colorfront.cloud 443/TCP (the IP address could be any of AWS’s CloudFront address
space)

Stream Manager Web Access [All region]

broker-test.colorfront.cloud 443/TCP (the IP address could be any of AWS’s CloudFront address
space)
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stream.colorfront.cloud 443/TCP (the IP address could be any of AWS’s CloudFront address
space)


The second hosts (stream-api/stream/stream-eval) will be utilized as soon as all users are
migrated to the production instance.



To obtain the actual AWS CloudFront address space, you can use the following command:

$ curl -s https://ip-ranges.amazonaws.com/ip-ranges.json | jq
-r '.prefixes[] | select (.service=="CLOUDFRONT") | .ip_prefix'
| sort -V

WebRTC Streaming Server Side (From StS/TKD/QCP/OSD/EXD) [All region]

srt-auto.millicast.com UDP/10000 [outbound]

Based on DNS records, the current IP addresses for srt-auto.millicast.com
could be any of the following:

• 129.153.125.139

• 158.101.22.33

• 144.24.0.201

• 129.146.113.97

• 132.226.147.204

• 141.148.142.156


These addresses are managed by a third party and may
be subject to change without our control or knowledge.

WebRTC Streaming Viewer Side [All region]

https://viewer.colorfront.cloud 443/TCP (the IP address could be any of AWS’s CloudFront address
space)

8.4. Security Best Practice

8.4.1. Implementing the Principle of Least Privilege

For the most secure deployment of your Colorfront Streaming Server in the cloud, it is imperative to adopt
the Principle of Least Privilege (PoLP). This foundational security guideline ensures that each component
of your deployment operates with the minimum levels of access and permissions necessary to perform its
functions. By strictly applying PoLP, you significantly mitigate the risk of unauthorized access and
potential security breaches.

Here are the key steps to implement PoLP:
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Role Analysis Carefully evaluate the roles within your deployment environment. Identify
specific tasks and determine the minimum level of access required for each
role to perform its functions effectively.

Access Control Assign permissions based on the roles identified. Ensure that each user,
application, and system component has access only to the resources that
are essential for their tasks.

Regular Audits Conduct regular audits of permissions and roles. This helps in identifying
and correcting any deviations from the least privilege principle over time.

Security Training Educate all users on the importance of PoLP and the specific practices in
place within your deployment. Awareness is key to maintaining a secure
environment.

Incident Response Plan Have a robust incident response plan in place. In the event of a security
breach, this plan will guide your team in quickly and effectively mitigating
any damage.

By implementing the Principle of Least Privilege, you ensure a secure and efficient environment for your
Colorfront Streaming Server in the cloud. This approach safeguards your data and systems while boosting
customer confidence in the reliability and safety of your services.

8.4.2. EC2 Backup and Recovery

To access the best policy for EC2 backups, please refer to this link.

8.4.3. Billable and Required Services

• EC2 Services (Mandatory): You will be billed for all usage of the EC2 instance while it is running.

• Egress (Mandatory): Egress fees apply to all data exiting your AWS deployment.

• Service Limits: For best practice, refer to this link.
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9. Client Application
9.1. Getting Started
Colorfront will provide you with the Streaming Player application software that is available for both
Windows and macOS systems. The app should be installed by double-clicking the relevant .msi (on
Windows) or .pkg (on macOS) file and following the prompts. The installer will create a Streaming Player
icon on the desktop.

Streaming Player icon

If you are using either a AJA or BlackMagic SDI device, you will need to download and install the necessary
drivers/software on the system for them to be usable.

Most of the time, the stream invitation link, which is sent via email, contains the license information that
allows Streaming Server to be launched, and the viewer does not need to take any action. If you get a
license string, please start the application and enter the received license key into the license entry window.
This is a 18-character numeric string.


For the first validation of the received license key, an active Internet connection is
required.

License entry window for the Streaming Player

9.2. Stream Connection
Colorfront offers a variety of configuration solutions for remote streaming to meet different individual
customer needs and security requirements.

You can connect to a stream in the following ways:
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Invite URL The easiest way to connect to a stream from the Streaming Player is to simply
click on a custom URL sent by the partner.

Colorfront’s proprietary Stream Manager is the most convenient intermediary
between the streaming source and the client and can also be used for generating
URL invite links. The Stream Manager can be flexibly customized and allows
parallel streaming to a vast number of clients that have the Streaming Player
application installed on their computer or other devices. It also ensures high
quality color encoding and robust, low latency viewing experience. Stream
invitations can be sent from the Stream Manager to multiple users at once. The
generated URL links will be automatically sent to the recipients via email.

You can also join the stream session through direct invite URL links, generated
from various Colorfront systems.

Via Apple device Use a code generated from an Apple device such as an iPad, iPhone, or Apple TV
to join the stream.

Direct connection Connect directly to the streaming source by manually configuring all connection
parameters.

See URL Links for Streaming Player for how to set up an invite link for the Streaming Player.

9.3. UI and Navigation
The Streaming Player has a simple user interface with a navigation bar at the bottom. It consists of:

• timeline showing the current frame position

• status icons

• timecode display

• mute button and audio bar

• various configuration and information buttons
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Streaming Player

The bar can be displayed or hidden by the View › Show/Hide Navigation Bar menu option, or using the G
shortcut.

View menu options of the Streaming Player

9.3.1. Status Icons

The status icons on the left side of the navigation bar indicate the stream’s health.

As for color coding, the icons turn green in case of connection or availability, while yellow/red icons
indicate performance issues. See Troubleshooting for Streaming Player for details on color coding and
what to do if an icon is not green.

The status icons are the following:

 Remote control status
green when remote controlling is established

 Stream connection status
        green when connected

 Encryption status
green for encrypted and gray for unencrypted
streaming
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 Stream quality
green when streaming is realtime

 Performance
green when hardware decoding is seamless

 Video I/O
green when video output is established and gray when
there is no video IO

 HDR mode
white text for HDR content; icon is crossed-out and
gray when stream is not HDR



HDR signaling is enabled in any of the
HDR modes via SDI or HDMI of AJA
boards, such as KONA 4 or KONA 5, and
a number of Blackmagic Design
devices, such as DeckLink 8K Pro,
DeckLink Mini Monitor 4K, DeckLink
Duo 2 or DeckLink 4K Extreme 12G.

 Dolby Vision Dolby Vision logo only when relevant metadata is
available


For Dolby Vision tunneling, the HDMI
link uses Dolby’s proprietary IPT color
space.


Status icons are currently not available in the main screen on the Mac platform, only on
the Performance page. Double-click to view them.

9.3.2. Center Displays and Buttons

In the center of the navigation bar, there is a timecode display of the incoming footage.



The timecode is the eight-digit numeric representation of a particular frame of the video,
as follows:

Hours:Minutes:Seconds:Frames

For example, 00:17:22:07 refers to the seventh frame of the video at 17 minutes and 22
seconds.

You can monitor audio levels with the small audio level indicator. Click the mute button to mute the
sound.


The mute button behavior depends on the Mute Scope parameter in the [Advanced
Settings]. It defines whether muting affects [Video Out], [System Audio], or [Both]
(default). Adjust this setting to control which outputs are silenced when mute is enabled.
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Mute button, timecode and audio indicator in the navigation bar

By default, the Streaming Player is in view-only mode, meaning playback controls are hidden and remote
controlling is disabled. To see the basic navigation controls on the right side of the bottom bar, such as the
Play/Pause, Previous Frame and Next Frame buttons, enable full remote control REST API access in the
server application.

9.3.3. Information and Configuration Buttons

The play button on the right side of the navigation bar is used to generate access codes for the stream.

Information and configuration buttons on the navigation bar

The Settings page can be accessed by clicking on the cogwheel icon or by hitting [Tab].

Next to it is an information icon that opens the Performance page, which is also accessible by double-
clicking anywhere on the screen.

Performance Page of the Streaming Player

9.3.4. Navigation on Apple Devices

Touch and swipe interaction is supported on both iOS devices and Apple TV. See the following table for
navigation details.

Navigation Action

On all Apple devices*

Swipe up Switching between Performance Page and image

Swipe down Enabling the bottom navigation bar while switching between Performance
Page and image

80



Navigation Action

Swipe left/right Switching between image / image+navigation bar / Performance
Page+navigation bar

Only iPad and iPhone

Single tap On mute button to mute the audio

Double tap Resizing of the main image as Fit (fit to screen) or FitAll (original scale)

Three-finger touch and
hold

Code generation to log in to the stream

Only Apple TV

Mute button on the
remote

Mutes the audio

Play button on the
remote

Code generation to log in to the stream

* Swiping on the touch surface of the remote (Apple TV) or on the screen of the device (iPad/iPhone)

To prevent any interference with the stream, it is possible to disable user interactions for viewing the
metrics. To deactivate all user interaction, follow these steps:

1. Go to Settings.

2. Access Application Preferences.

3. Click Disable User Interaction.

9.4. Viewing the Stream
There are several ways to look at the video content when using the Streaming Player application. Most
importantly, you can use

• a directly connected GUI monitor, including the XDR display on the Mac, or

• a professional AJA or Blackmagic Video Output Device and connect to an external HDMI or SDI
monitor.

• You can also use the Streaming Player App on Apple TV and iOS Devices. See the step-by-step
installation guide.

When you first open the Streaming Player, a screen message will invite you to connect to a demo stream.
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Start demo stream

Click the link and enter your email address in the pop-up window. You will receive a code via email to verify
your identity in the Streaming Player to start the demo stream. You can interrupt and rejoin the stream
multiple times, or join from another device with a code.

The demo stream contains watermarks including your IP and email address.

Watermarked demo stream

9.4.1. Performance and Quality

Streaming technology encompasses a wide range of resolutions and formats, including HD, UHD, or 8K,
with color encodings such as RGB 444 or YUV 420, alongside variable bitrates that can range from low to
very high. These critical settings determine the stream’s overall quality and require precise adjustment on
the server side. It is important to note that compatibility with these settings varies across playback
devices; for instance, AppleTV may not support UHD with RGB 444 encoding.

Adjustments on the Streaming Player side, particularly in terms of network buffering, can directly impact
latency, ensuring a smoother viewer experience.



For optimal performance with the Network Buffering parameter set to [Ultra Low
Latency] in the Advanced Settings of the Streaming Player, it is recommended to switch
the streaming server to PCM audio. Unlike the default AAC option, which delivers
compressed audio, PCM offers lossless quality. Despite the higher data rate, PCM
provides superior quality and reduced latency.

When using PCM audio, Streaming Server also supports multichannel 5.1 and 7.1 output on Mac and iPad
devices if compatible hardware is available. This enables full-quality multichannel playback without
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compression, ideal for QC and professional review workflows.

The quality and performance of the streaming content can be adversely affected by the network
environment. WiFi and VPN connections, in particular, often lead to notable slowdowns, potentially
compromising stream quality.

9.4.2. Directly Connected Displays

You can connect HDR-capable displays directly to the Streaming Player on both macOS and Windows.
Refer to the following sections for platform-specific instructions on configuring HDR display output.

To toggle full-screen mode in the Streaming Player, use the Alt+Enter keyboard shortcut.

On macOS, full-screen mode can also be activated by clicking the green button in the top-left corner of the
application window. In this mode, video content fills the screen and audio is played through the system’s
default output.

Directly Connected Displays via DisplayPort on macOS

To use a graphics monitor directly, take the following steps:

1. Connect the display through the DisplayPort of your Mac workstation.

2. Go to the display settings of your Mac and set the Brightness slider to its maximum value. The Preset
selector should be set to [HDR Video (P3-ST 2084)] for HDR displays.

Selecting the P3-ST 2084 preset for HDR video display

3. For non-HDR content, select the [Rec. ITU-R BT.709-5] (Rec. 709) setting as your default Colour
Profile. When viewing HDR video on a non-XDR display, choose the [Rec. ITU-R BY.2020-1] (Rec.
2020) color profile for an optimal viewing experience.
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Selecting proper display profile

4. Start the Streaming Player.

5. For HDR, navigate to the Advanced Settings and set the Gui HDR Mode from [SDR] to [HDR10] to
trigger the HDR mode on the display.

Selecting HDR display mode on the Settings Page

Directly Connected Displays via HDMI on macOS

Another option to view the Streaming Server’s streamed HDR content through a direct display is to
connect an LG OLED TV to the supported Mac configuration (such as Mac Pro) via the HDMI port, as per
the following:

1. Connect the television through the HDMI port of your Mac workstation.

2. Go to the display settings of your Mac, and enable the High Dinamic Range option so that the display
shows HDR content. Make sure that the Colour Profile is also set to the appropriate option.
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Enabling HDR mode in the display settings on the Mac

3. Start the Streaming Player and go to the Settings Page.

4. For color-accurate monitoring, go the Advanced Settings and enable the HDMI Gui Brightness to
compensate HDMI brightness on the GUI output.

 The HDMI Gui Brightness setting is only available on macOS.

Selecting GUI brightness compensation for the GUI

Directly Connected Displays on Windows

When using the Streaming Player on a Windows workstation, please do the following:

1. Connect the display, GUI monitor or TV, through the appropriate port of the workstation. The monitor
should be HDR10 capable. For HDR televisions, use the HDMI port of the computer.

2. Go to the displays settings of the Windows operating system, and switch to HDR mode.

3. Start the Streaming Player and go to the Settings Page.

4. Set the Gui HDR Mode to [HDR10] display mode for all direct connections, including HDMI.
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Selecting HDR GUI display mode on the Settings Page on Windows

9.4.3. Video Output Device

If an AJA or Blackmagic Design device is installed in the system, you can customize the video output on
the Settings Page as follows:

Video Out Set it to [HDMI], [SDI] or [Off].

Video Resolution It should match the server’s video setting. To send HD 720p resolution video to
the video output, set this to [Auto].

Color Space Set the SDI output color space to [YCbCr 10 bit], [RGB 10 bit] or [RGB 12 bit].

SDI Transport Set to [Auto] or to the appropriate SDI configuration.

Dual Video Out Enable a secondary video output by choosing a color space for the output. Select
either [SDR] or [HDR].

The transmission also consists of the audio stream. The audio is transmitted to the video card, and may be
output to a monitor or television over SDI or HDMI interface.

9.4.4. Disabled Screen Capturing

To protect sensitive content, all forms of screen capturing is blocked in the Streaming Player, such as
taking screenshots or recording screen content.

Viewing streamed video content of the Streaming Player through any remote desktop application is also
disabled. While the audio signal is transmitted to the remote party, no image is visible from remote
access. For support purposes, you can allow limited access to the application’s settings by enabling the
Support Mode.

9.4.5. Advanced Configurations

Custom GUI Color Space

The Streaming Server supports defining a custom GUI color space through the Startup.xml file. This
advanced configuration affects only the GUI display and does not alter the streamed or video output
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signal. It allows GUI color management customization for specific display workflows, such as Apple P3
monitors or SDR/HDR mixed environments.


This feature is available only through the Startup.xml file and is not accessible from the
user interface.

Add the following entry to the Startup.xml:

<CustomGUIColorspace type="string">P3D65_SRGB</CustomGUIColorspace>

The value follows the Primary_Curve format:

• The part before the underscore defines the color primaries.

• The part after the underscore defines the gamma or transfer curve.

Examples:

• P3D65_SRGB (Apple Display P3)

• BT709_Gamma24

• BT2020_PQ

Available options:

Primaries BT709, Rec709, BT2020, Rec2020, P3DCI, P3D65, XYZ, AP0, AP1, ARRIWideGamut,
CanonCinemaGamut, RedWideGamutRGB, Sgamut3Cine, VGamut

Curves SRGB, Gamma22, Gamma24, Gamma26, BT1886, HLG, PQ, ACEScct, LogC, Slog3

9.5. Streaming Player App
You can watch media content on Apple TV and iOS devices such as iPad or iPhone through the Streaming
Player app.

Apple TV device

Please see the Streaming Player manual on how to join a streaming session by clicking on the URL sent to
you in email.


Currently, the Streaming Player does not open on iPhone from email when the default
browser is Microsoft Edge.
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Key Features of Streaming Player App

• Reference-quality 10-bit 420 HEVC video stream

• Sub-second latency for truly interactive sessions

• Secure transport with 128/256-bit AES encryption and optional visible and forensic watermarking

• Flexible data rates from below 10 up to multiple hundreds of Mbps

• Rec.709 and PQ color space support

• Dolby Vision

• Disabled screen capturing to ensure content security

Streaming Player App on the GUI of Apple TV

9.5.1. Prerequisites

Supported hardware platforms, setups and formats are the following:

System Supported Versions

Apple TV model • 4K (2nd generation) - recommended
• 4K (1st generation) - with limited functions

 Currently, AppleTV HD is not supported.

tvOS tvOS 15.0 and above - 15.5 recommended

iPad model iPad Pro 4th Generation 12.9" or later

iPadOS iPadOS 14.5 and above

iPhone model iPhone 12 and 13 Pro/Pro Max or later

iOS device Devices equipped with Apple A12 Bionic 6-core processor or above
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System Supported Versions

Web browser Safari, Chrome and Firefox


Currently, Streaming Player does not open on iPhone
from email when the default browser is Microsoft
Edge.

Stream format 10-bit 420 HEVC video stream


Currently, 10-bit 444 HEVC video stream is not
supported on Apple TV.

UHD HDR 420/444 support • iPhone 12 Mini and up, with reduced stream quality for iPhone SE
(3rd generation)
• iPad Air (3rd generation) and up
• iPad Pro 12.9-in. (3rd generation) and up

8K support iPad Pro 12.9-in. (5th generation) and up

Internet connection For best performance, we strongly recommend using hard-wired
Ethernet cable for your system. If hard-wired connection is not
possible, you can also use Wifi for streaming.

HDMI connection The Apple TV is HDMI 2.0a capable, which can be connected to any
input of the Television.

Picture Mode settings Although many manufacturers/televisions differ, it is generally
recommended to disable features such as motion compensation (e.g.
LG TruMotion) or dynamic contrast options that may interfere with
the original creative intent. However, picture settings such as
Filmmaker Mode are recommended.



Filmmaker Mode automatically disables any picture
processing settings that can often distort the natural
look of movies, ensuring they are displayed as
intended by their directors by preserving the film’s
original aspect ratio, colors, and frame rate, and
delivering a more authentic and true-to-source
viewing experience.

9.5.2. Apple TV

Installation on Apple TV

To install the Streaming Player App on Apple TV, please follow these steps:

1. On your Apple TV, go to the App Store.
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Apple TV App Store

2. Search or type in ‘Colorfront’.

3. Select the Streaming Player application icon and click [Get].

4. Once the download is complete, return to the main screen and tap the Streaming Player App icon to
open it.

5. Before connecting to a stream using the Streaming Player App, you need to verify your identity. For
detailed instructions, please refer to the Email Verification for Stream Access section.
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Code Generation on Apple TV

To generate a code from the Streaming Player App installed on your Apple TV to access the video stream,
follow these steps:

1. Open the stream invitation email. The message will include a [Join with Code on Other Device] button
that will take you to the Device Login Page. Here you will need to enter a six-digit invitation code
generated by your Streaming Player App within the Apple TV.

2. Go the GUI of the Apple TV.

3. On the Apple TV home screen, open the Streaming Server App.

4. On the Siri Remote controller, press the Play/Pause button.

5. A 6-digit alphanumeric code will appear on the screen.

6. Go back to the Device Login Page on the device that you used to open the stream invitation email
(such as your mobile phone or computer) and enter the code.

7. Once the code is validated, the stream will start automatically on Apple TV.

8. Closing the application will stop streaming data with the Streaming Player App, but as long as the
streaming session is live, you can rejoin the stream by reopening the application.
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Entering code on Device Login Page

Siri Remote Controller

Touch and swipe interaction is supported on Apple TV using the Siri Remote controller, where you can
swipe by touching across the touch surface of the remote with a sliding gesture. See the following table for
navigation details.

Touch surface of Siri Remote controller

Navigation Action

Swipe up Switching between Performance Page and image

Swipe down Enabling the bottom navigation bar while switching between Performance
Page and image

Swipe left/right Switching between image / image+navigation bar / Performance
Page+navigation bar

Mute button on the
remote

Mutes the audio

Play button on the
remote

Code generation to log in to the stream
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Streaming Player Performance Page with navigation bar

StP App Settings

1. Access Settings from the Apple TV Home Screen.

2. Select Apps.

3. Select Streaming Player.
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To see how to configure streaming source parameters, see Application Settings.

Apple TV Video Settings

In the Settings, open Video and Audio where you can configure the Format of the video stream.

For an optimal review experience, please choose a 4K video format. 4K options include [4K HDR], [4K
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SDR] and [4K Dolby Vision] in 50/60 Hz formats.

If you have a Dolby Vision compatible television (such as LG or Sony), for the best quality and experience,
please set your Apple TV to [4K Dolby Vision] video format. This is especially important if you want to
review HDR materials. However, even for SDR videos, we encourage you to set your Apple TV device and
television to Dolby Vision format.

Selecting 4K Dolby Vision video format

If Dolby Vision is not available but you have a HDR-compatible TV (such as Samsung), please select an
HDR format option.


Please note that the HDR-compatible TV should immediately display an HDR or HDR10
logo if any of the [4K HDR] format options is selected on the Apple TV.

As for Chroma settings, for HDR10 content, it is best to set the hue subsampling to the maximum value.
The choices on Apple TV are [4:2:0] or [4:2:2]. Please set to the latter.

Setting Chroma to 4:2:2

Other Stream Parameters

Color Conversion

Either your Apple TV is configured for SDR (Rec.709, Gamma 2.4 at 100 nits) or HDR (with HDR10 or Dolby
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Vision), the Streaming Player will handle the color conversion as needed.

As an example, you can send a 48 nits, Gamma 2.6 video with P3 DCI primary to the Apple TV Streaming
Player, and the application will receive the signal “as is” and perform the appropriate color conversion to
make the images look as good as possible on your television screen. This color conversion is based on
Colorfront’s advanced Perceptual Processing Engine (PPE), aka the Colorfront Engine, which is a complex
color processing model based on human visual perception to ensure a perceived match between SDR and
HDR outputs while preserving the artistic intent of the original source material.

Finally, if the incoming stream or signal is the same color as the destination (Apple TV Streaming Player),
no conversion is applied. A visual indication of the incoming signal as Input Color and of the destination
color as GUI Color is shown on the Streaming Player’s Performance Page.

Force SDR Display Mode

In some workflows, especially when connecting Apple TV to professional SDR monitors or converting
HDMI to SDI signals, it is necessary to disable automatic color space conversion and HDR tunneling. This
ensures the preservation of exact Rec.709 color characteristics without unintended HDR processing.

The Streaming Player app on Apple TV includes a Force SDR Display Mode setting, available in the App
preferences. When enabled, this option forces the Apple TV’s HDMI output to behave as a true Rec.709
SDR signal, bypassing any internal HDR signaling or color conversions. This ensures that the HDMI output
matches the original stream characteristics as closely as possible (except for legal/full range adjustments
if necessary), without altering gamut, gamma, white point, or dynamic range.


After enabling the Force SDR Display Mode setting, you must restart the Streaming Player
app for the changes to take full effect.

Dolby Vision Remap

If the stream contains Dolby Vision metadata, a Dolby Vision logo will appear in the navigation bar of the
GUI. In the Streaming Player App preferences, you can select Dolby Vision Remap and choose one of the
Dolby Vision target options that you want to see, such as [Auto], [SDR], [600 nits], [1000 nits] and [2000
nits].

This setting controls the content mapping in the Streaming Player App itself. It allows previewing any
target via the application, such as SDR, and not just a "fixed" remap performed on your television.

Selecting Dolby Vision target remap options
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Audio Stream on Apple TV

The Apple TV Streaming Player application supports stereo only (2-channel) audio output over HDMI.
However, the audio stream can be configured with up to 8 separate audio channels. The application will
display all eight audio channels in the GUI and will mix them down to stereo configuration for monitoring,
e.g. mixing down 5.1 (L, R, C, LFE, Ls, Rs) to stereo.

Screen Capture

In order to protect sensitive content, all forms of screen capturing is blocked in Streaming Player, such as
taking screenshots or recording screen content.

9.5.3. iOS Devices

Installation on iPad/iPhone

To install the Streaming Player App on your iOS device, such as an iPad or iPhone, please follow these
steps:

1. On your iOS device, open the App Store.

2. In the App Store app, search for ‘colorfront’ or 'streaming player'.

3. Locate the Streaming Player app and tap [Get] to download it.

4. Once the download is complete, return to the main screen and tap the Streaming Player App icon to
open it.
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5. Before connecting to a stream using the Streaming Player App, you need to verify your identity. For
detailed instructions, please refer to the Email Verification for Stream Access section.

Code Generation on iOS Device

To generate a code from the Streaming Player App installed on your iPhone or iPad to access the video
stream, follow these steps:

1. Open the stream invitation email. In the message click the [Join with Code on Other Device] button
that will take you to the Device Login Page.

2. Open the Streaming Server application on your iPhone/iPad.

3. Place three fingers on the screen and hold it for a few seconds.

4. A 6-digit alphanumeric code will appear on the screen.

5. Go back to the Device Login Page and enter the code.



You may use a separate device (such as your mobile phone or computer) to read the
stream invitation email and then open the Device Login Page, and another device
(such as an iPad) to view the stream through Streaming Player, or use the same device
for both.

6. Once the code is validated, the stream will automatically start on your iPad/iPhone.

7. Closing the application will stop streaming data on the iOS device, but as long as the streaming session
is live, you can rejoin the stream by reopening the Streaming Server app.

Brightness Configuration

Image brightness must be set up in different ways for proper viewing depending on whether the goal is to
critically review the content with an iOS device, such as an iPad Pro. In addition, brightness configuration
depends not only on the dynamic range of the footage (SDR or HDR), but also on the display used for
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viewing it.

There are two use cases when adjusting the image brightness on iOS devices:

Reference mode It is used for performing critical QC and making informed color decisions in a
dark environment. When this mode is enabled, content colors and image
brightness are accurate as seen on a calibrated, professional reference
monitor. However, it is highly recommended using a device with an XDR
display.

Non-reference mode It is used to view technically correct image using the Streaming Player with
factory default settings, in various lighting conditions, adapted to the viewing
environment.

For devices with advanced XDR display and iOS 16 (and above), use the Reference Mode in the iOS
Display & Brightness settings. While the Streaming Player app also has an optional Reference Mode
parameter, it will automatically follow this system setting.


iOS-level reference mode requires 12.9-inch iPad Pro (5th generation or later) and iPadOS
16 or later.

For HDR content, the Reference Mode adjusts brightness to the PQ value of the footage, while SDR
images are limited to 100 nits.


When iOS-level Reference Mode is on, the brightness slider is disabled, and true tone,
auto brightness and night shift are not available.
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Reference Mode in the Display & Brightness system settings

On all other iOS devices, enable Reference Mode in the Streaming Player app settings to see color- and
brightness-accurate images as seen on a professional reference monitor.

Reference Mode in the Streaming Player app settings

9.5.4. Email Verification for Stream Access

In order to ensure a secure and reliable experience for users of the Streaming Player App, a one-time email
verification process is essential. This verification step is designed to confirm the user’s identity and grant
access to the app’s streaming functionality. By validating the provided email address, we ensure that only
authorized individuals can access the app’s features. Please follow this steps:

1. Launch the Streaming Player App.

2. In the pop-up window, enter your email for one-time authentication and press [OK].
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3. You will receive an email containing a verification code. Enter this code in the next pop-up window in
the Streaming Player App.

4. Upon successful verification, a six-character alphanumeric access code will be displayed.

5. Enter this access code in the Stream Manager for the selected stream. On the Streams Page, click the
Play button next to the streaming channel name. In the panel that opens on the left, paste the code
into the Join with device field.

101




If needed, contact your TM for assistance with the Stream Manager interface, or refer
to the Streaming Server manual.

6. After entering and confirming the access code, the stream starts automatically on your iOS device or
Apple TV.

9.5.5. Application Settings

Open Settings on your Apple TV or iOS device, then the Streaming Player app settings. Here you can
modify the following parameters.

Selecting StP settings on iOS device

E-mail Email identification to communicate with Colorfront’s Stream Manager.

Reference Mode For Apple TV, leave this setting disabled for SDR content, i.e. at 200 nits.
When enabled, the brightness value is at maximum 100 nits on the HDMI
HDR output, as seen on a calibrated, professional reference monitor.
For iOS devices, see Brightness Configuration for details.


Check the GUI Color parameter on the Performance page
to see the maximum dynamic range (in nits) of the video
output.

Dolby Vision Remap For Dolby Vision High Dynamic Range streams, enable and set to any
available target nit level options or SDR preview. Options are: [Off], [Auto],
[SDR], [600 nits], [1000 nits] and [2000 nits].

Auto Hide GUI Enter any value that specifies the number of seconds after which the
bottom navigation bar automatically disappears from the GUI. Default is 12
seconds.

Network Buffering Specifies how much error correction the streaming application should
perform in terms of latency. Options are: [Ultra Low Latency], [Low
Latency], [Balanced] (default) and [Reliable].

Disable User Interaction Deactivate all user interaction to prevent any interference with the stream.
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Version Displays the build version of the installed Streaming Player application.

9.6. Hardware Configurations

9.6.1. Minimum Hardware Requirement

The minimum hardware requirement for the Streaming Player application is as follows:

Minimum Windows hardware requirement

CPU i5-8400 or faster for desktop, i5-8300H or faster for mobile

Memory 16+ GB dual channel DDR4-2400 or faster

GPU RTX4000 or faster for desktop, T1000 or faster for mobile (minimum PCIe x16 Gen3 slot)

Display HD resolution or above



On client-side systems, 444 hardware decoding is only supported by NVIDIA Turing GPUs,
such as T1000, T2000 and RTX4000.

Pascal GPUs are also supported, but their decoding capability is limited to 420. If you use
a Pascal GPU for 444 formats, decoding will be performed on the CPU of the system,
which can affect performance.

Supported Mac hardware

Memory 8+ GB

• Intel MacBook Pros 2019 or later with AMD GPU

• MacBook Pro with Apple Silicon

• Mac mini with Apple Silicon

• iMac with Apple Silicon

• Mac Pro 2019 or later with AMD GPU

9.6.2. Recommended Configurations

Recommended hardware configurations for the Streaming Player are the following:

Mac mini configuration

Workstation Apple Mac mini. See here.

CPU Apple Silicon

Memory 16 GB unified memory

Storage 256GB SSD
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Display SDI/HDMI monitor connected to the AJA T-Tap Pro or Black Magic Design UltraStudio
4K Mini, or a directly connected XDR display

Example Windows PC configuration

Workstation HP Z2 Tower. See here.

CPU Intel® Core™ i9-9900 processor. See here.

Memory Minimum of 2x8GB. Recommended: 2x16GB

Storage 256GB SSD

GPU NVIDIA Quadro RTX 4000, driver version 442.50

SDI/HDMI AJA KONA 5 or Blackmagic Design DeckLink Mini Monitor 4K

Monitor A screen resolution of at least 1920x1080 is required. A resolution of 2560 or 3840 is
recommended.

Example 1RU Rack Mount Chassis Configuration

Workstation SuperChassis 514-R407W. See here.

Motherboard X11SPW-TF. See here.

CPU Intel® Xeon® Silver 4210R processor. See here.

Memory Minimum of 2x8GB. Recommended: 2x16GB

GPU NVIDIA Quadro RTX4000, driver version 442.50

SDI AJA KONA 5 and BMD DeckLink Mini Monitor 4K

Example Laptop Configuration

Laptop HP ZBook 15 G6 Mobile Workstation with Windows 10 Pro or Windows 11. See here.

CPU Intel® Core™ i9-9880H vPro™ processor (2.3 GHz, up to 4.8 GHz with Turbo Boost, 16 MB
cache, 8 core). See here.

Memory 32 GB (4x8 GB) DDR4 2666

GPU NVIDIA® Quadro® T1000 (4 GB GDDR5 dedicated)

SDI AJA Io4K+ or Blackmagic UltraStudio 4K Mini

Display 15.6" diagonal UHD B-LED UWVA Anti-Glare DreamColor slim (3840x2160) (600 nits)
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9.7. Troubleshooting for Streaming Player

9.7.1. Support Mode

If you need remote assistance from our Support Team regarding the Streaming Player, please switch the
software to Support Mode in the Advanced Settings.

In this mode, although the default Disabled Screen Capturing is still on, the GUI will only appear with the
Settings Page on the computer screen. While streaming continues, the streamed image will still be
blocked and not appear on the GUI, or on any remote screen connected via remote desktop software, such
as TeamViewer. This mode allows our Support Team to configure settings to resolve any issues with the
Streaming Player.

9.7.2. Color Coding for Status Icons

By examining the status icons and their color code, you can easily determine whether the streaming is
working properly or not. The color coding is as follows:

Green icons signify normal operation.

Yellow indicates borderline performance values.

Red signifies an error in the stream.

Gray represents that the corresponding element of the streaming pipeline is disabled.

Remote Control Status

Status Remote Control Status

Icon

Green The Remote Control Mode setting from the remote machine is enabled and
the streaming server’s API is accessible.

Red The above setting is enabled, but there is an error connecting to the
streaming server’s API.

Gray The above setting is disabled.

Troubleshooting There is a possible firewall issue on the streaming server’s side.



The remote control API is only available when streaming
straight from a Colorfront product such as Transkoder, QC
Player, OSD or ExD. Remote controlling cannot be enabled if
the server is a Colorfront Streaming Server or an SRT
gateway/HUB.
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Stream Connection Status

Status Stream Connection Status

Icon

Green The Streaming Player is able to receive/decode the stream.

Red The incoming, configured stream is not accessible.

Troubleshooting Please check the configured IP address and port number settings on the
Settings Page.

Please check if the server is running on the correct port and is in listening
mode.

If all these settings are correct, there is probably a firewall or network
configuration issue. Please contact your IT administrator.

Encryption Status

Status Encryption Status

Icon

Green The passphrase is correct on both sides. Thus, the stream is encrypted and can
be decrypted properly by the client.

Red There is no passphrase specified on the client side, or it is incorrect.

Gray No passphrase is set on the server side, so the stream content is not
encrypted.

Troubleshooting Please check that you entered the passphrase correctly.



If no passphrase is specified on the server side, the stream
will not be encrypted. In this case, the client does not need to
add a passphrase either.

However, if a passphrase is specified on the server side, the
stream will be encrypted, but will only work if the same
passphrase is entered on the client side.

Stream Quality Status

Status Stream Quality Status

Icon

Green Smooth operation. The stream arrives properly and is played back in real time.
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Status Stream Quality Status

Yellow The stream arrives, but packet recovery is reaching its upper limit. If this state
persists, operational issues may arise.

Red Packet loss exceeds 30%.

Gray No stream available.

Troubleshooting Please check the values for Packet loss rate and Lost/Drop/Fixed on the
Performance page.

• If the packet loss rate is above 25%, the bitrate is too high for the current
network connection. Please decrease the bitrate.

• If the Drop value is greater than 0, there is a possible network quality
and/or connection issue. Please decrease the bitrate or check your
network connection.

Performance Status

Status Performance Status

Icon

Green Smooth performance. The hardware is capable of decoding the arriving
stream in real time.

Yellow "Local performance" issue: Frame processing takes longer than real-time
periodically.

"Remote performance" issue: The server side cannot render the stream in real
time.

Red Frame processing takes longer than real-time permanently. As a result,
latency is constantly increasing.
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Status Performance Status

Troubleshooting If indicates yellow "Local performance" issue: Set the Network Buffering
parameter from [Ultra Low Latency] to [Low Latency], or from [Balanced] to
[Reliable] in the Advanced Settings so that the system can compensate for
periodical delays without dropped frames.

If indicates yellow "Remote performance" issue: Check what is causing the
performance problem on the server side. Server hardware capacity may be
insufficient.

If red: The hardware is incapable of rendering the stream. You can either:

• use the recommended configurations,

• decrease stream resolution, and/or

• switch to 4:2:0 video chroma format.



To achieve optimal performance with [Ultra Low Latency], it
is recommended to switch the streaming server to PCM
audio. Unlike the default AAC option, which delivers
compressed audio, PCM offers lossless quality. Despite the
higher data rate, PCM provides superior quality and reduced
latency.

Video IO Status

Status Video IO Status

Icon

Green Video IO output is enabled and working properly.

Yellow There has been a frame drop within one minute but not within 10 seconds.

Red There has been a frame drop within 10 seconds. Alternatively, there is a
possible conflict between the video IO settings and the stream format. In this
case, more information is available on the Performance page.

Gray Video IO output is either unavailable or turned off.

Troubleshooting Other issues may have been culminated here. Please check if there are any
other status icons that indicate an error, and if so, refer to the corresponding
troubleshooting descriptions above.

If red permanently, and no other icons indicate an error, please check the
video IO board drivers and their configurations.
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10. Security Hardening
Colorfront offers a safe and secure remote streaming solution using the SRT (Secure Reliable Transport)
Protocol and 256-bit AES encryption, which ensures that content is protected even when transmitted over
the public internet.

To further enhance system safety and ensure studio-level security, you can take the following measures:

• Forensic and Visible Watermarking: NexGuard forensic watermarking and visible watermark burnt
into the pixels provide additional protection. Enable these features in the Streaming Channel 1-4 in the
Advanced settings.

• Force Disable SDI Output: You can set the External Video Output setting from the default to
[Prohibited] to disable the external SDI video output on the Streaming Player.

• Remote Control REST API Considerations: For added security, you can either restrict or deny the
remote control access to your system. To do this, the following line needs to be set in the Startup XML:
<RemoteControlRESTmode type="string"
enum="off,playback,full">off</RemoteControlRESTmode>

◦ To limit remote control access, set this parameter to playback mode, which only allows playback
controls.

◦ The off option disables the remote control REST API on port 1973 to prevent anyone from
accessing sensitive data over the local network. While this will deactivate the remote control option
and the use of the Colorfront Web UI, it provides a more secure system.

◦ Only if you need web control access, set it to full and run the Apache components on your
system.

• 10-Character Long Passphrase: For best security, use a randomized password of at least 10 characters
in case of direct streaming. When using Colorfront’s Stream Manager, however, the system
automatically populates the stream parameters, such as the passphrases for the available streaming
channels.

• Firewall Setup Considerations: If you are working in a high-security corporate network environment,
and your outgoing traffic is restricted or filtered, you must open the required ports on the UDP
protocol to allow outgoing streams. A separate open port is required for each streaming channel.

10.1. Hardening in the Stream Manager
Colorfront’s proprietary cloud-based Stream Manager provides a strong and secure streaming session
management interface with additional features to enhance protection, such as forced studio-grade
security with individual email invites that cannot be shared. It is always advisable to use the Stream
Manager for streaming, as all connection information remain hidden in the system, ensuring that
unauthorized persons cannot access the stream.

Team Managers of the Stream Manager can enforce a range of security features globally in their
organization, making sure these security measures are applied to all streams within the group:
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Hardening in the Stream Manager

• Invitation Expiration: Default value is 1 hour.

• Force Multi-Factor Authentication for Team Members: Users on your team will be forced to set up
MFA and secure their accounts. Enabling this setting will force you to secure your account as well.

• Display Watermarking in Players: This setting forces all channels to be using the watermarking. You
can also set the watermarking option per-channel in the Streaming Servers view. Users joining the
team’s sessions will see a watermarking text burned into the display when this option is turned on. This
watermarking is the email address of the invited user and a random string that identifies the user (can
be searched in activity logs).

• Custom Identity Provider: It allows members of an enterprise team to authenticate through the
company’s identity provider.

• Force Streaming Player Authentication for All Viewers: Viewers receiving invitation from your team
can only join the session after logging in and verifying their account. If you specify a custom identity
provider, viewers must authenticate through the identity provider you defined.

10.2. Restricting Network Communication
If you are using the Stream Manager, open port 443 to allow communication between Streaming Server
and the Stream Manager on TCP protocol. Regarding the necessary port numbers to open, please contact
your Stream Manager administrator.

Using Gateway: If you use your own Gateway service, enable inbound traffic for the ports that you have
configured in AWS.

Direct Streaming: For direct streaming, you must also set a NAT (Network Address Translation) service on
the firewall to allow secure direct access. Please contact your network administrator.

See the following table for details on the protocol and port settings required for the various streaming
setups.

Directio
n

Protocol Port Destination

Using Stream Manager
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Directio
n

Protocol Port Destination

Stream Manager API Out TCP 443 stream.colorfront.cloud

Streaming channels Out UDP Colorfront provides information per channel after
provisioning

Using Streaming Gateway service

Gateway API Out TCP 443 your gateway address

Streaming channel in
[Listener] mode

In UDP Streaming channel
settings/Port

Streaming channel in
[Caller] mode

Out UDP Listener port configured at
your gateway’s route

your gateway address

Direct streaming

Streaming channel in
[Listener] mode

In UDP Streaming channel
settings/Port

Streaming channel in
[Caller] mode

Out UDP Listener port configured at
your streaming destination

your destination address
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Appendix A: Settings Page
Pressing Tab or selecting the corresponding menu item from the drop-down menu opens the Settings
Page, where you can adjust the project settings.

Hold the right mouse button to scroll up and down the page.

Press the A key while on the Settings Page to view Advanced settings.

Settings Page Description

Streaming Channel
1-4

Settings for streaming channel 1/2/3/4 with separate Advanced section for each

Network Network settings

CDI CDI settings

Stream Manager Stream Manager settings

A.1. Streaming Channel 1-4 Settings
Setting Description Note

Resolution Resolution of the stream Options: [SameAsSource], [HD],
[2K], [UHD], [4K] , [8K]

Input Color Space Set the color space of the input
signal

[Auto] means that the color space
follows the source metadata

Options: [Auto], [HD709],
[HDR10], [P3D65PQ], [HLG],
[P3DCIGamma26],
[XYZGamma26],
[P3D65Gamma22],
[P3D65Gamma26], [Bypass]

Output Color Space Set the color space of the output
signal

[Auto] follows the current setting
of the Input Color Space

Options: [Auto], [HD709],
[HDR10], [P3D65PQ], [HLG],
[P3DCIGamma26],
[XYZGamma26],
[P3D65Gamma22],
[P3D65Gamma26], [Dolby
Vision]

Bitrate Output stream bitrate in Mbps

Address Destination address

Port Destination port number

Connection Type Selects the connection mode for
streaming via an SRT gateway

Options: [Listener], [Caller]

Encryption Passphrase 10-80 characters passphrase for
encryption, where empty means
no encryption on outgoing stream

For P2P configuration only!
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Setting Description Note

Visible Watermark Add text to burn into the video
stream

Visible Watermark Transparency Transparency of text to burn into
the video stream

A.1.1. Advanced Streaming Channel 1-4 Settings

Setting Description Note

Audio Encoder Audio encoding format Options are [AAC] or [PCM]

Audio Channel Count Number of audio channels Options are [8] or [16]

B Frames B frame number in GOP pattern

Video Chroma Format Video chroma format of the
stream

Options: [4:2:0] or [4:4:4]

Enable Audio Enable audio stream

Stream Waveform Enable to send the waveform of
the image in the stream (instead
of the image itself)

Streaming Output Format Stream output format Options: [RTP] or [SRT]

Connection Timeout Connection timeout in Msec

Watermarking Enable forensic watermarking

Watermarking ID Payload ID for forensic
watermarking

External Video Output Allow external video output on
Streaming Player

Options: [Allowed], [Prohibited]

Streaming Log Database Target path for the streaming log
database

Halved HFR Stream Enable it to halve frame rate in
HFR modes by dropping every
second frame

Custom Input LUT Enable to apply custom input LUT
to the stream

Secondary Stream Enable an alternative lower
latency viewing option

Secondary Stream Target Use [WebRTC] (default) or
[Gateway] for the secondary
stream
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A.2. Network Settings
Ethernet-1 and Ethernet-2

Setting Description Note

DHCP When DHCP is enabled, the
system will automatically obtain
an IP address

IP Address IP address if DHCP is disabled

Subnet Mask Subnet mask if DHCP is disabled

Default Gateway Default Gateway if DHCP is
disabled

DHCP DNS When DHCP DNS is enabled, the
system will automatically obtain
the DNS servers

DNS Server 1 DNS Server if DHCP DNS is
disabled

DNS Server 2 Alternative DNS Server if DNS
DHCP is disabled

General

Setting Description Note

Shared IP for Direct Stream Enter the IP address to be used
for invite link generation

If empty, the invite link will use
the local IP address

A.3. CDI Settings
Setting Description Note

CDI Adapter IP IP address for the CDI EFA
Adapter

Default is: 127.0.0.1

CDI Port / Input A Listening port for Input A Default is: 2000

CDI Port / Input B Listening port for Input B Default is: 2001

CDI Port / Input C Listening port for Input C Default is: 2002

CDI Port / Input D Listening port for Input D Default is: 2003

A.4. Stream Manager Settings
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Setting Description Note

Manage SRT Gateway Manage the SRT gateway
destinations

Use Stream Manager Enable Stream Manager for
stream configuration

P2P Streaming with Manager Manager direct stream sessions
via the Stream Manager

Further configuration is required.
Please contact your Super Admin.

Stream Manager Address IP address or host name of the
SRT gateway

Stream Manager User SRT Gateway username

Stream Manager Password Password for Stream
Manager/SRT Gateway username

Streaming Player License Optional license for Streaming
Player application to embed into
invite link
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Appendix B: Keyboard Shortcuts
Shortcuts used in Streaming Server are listed below.

Keyboard Shortcut Command

Ctrl+T Timecode on Image

Tab Settings

A (while on Settings Page) View Advanced settings

Shift+Enter Four-channel view

F9 Cycles through channels 1-4 for quadrant 1

F10 Cycles through channels 1-4 for quadrant 2

F11 Cycles through channels 1-4 for quadrant 3

F12 Cycles through channels 1-4 for quadrant 4

F5 Toggles image/waveform view for quadrant 1

F6 Toggles image/waveform view for quadrant 2

F7 Toggles image/waveform view for quadrant 3

F8 Toggles image/waveform view for quadrant 4

Alt+/ About
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Appendix C: Troubleshooting
Should any issues or questions arise, please Contact Customer Support. In order to provide you with
support as efficiently as possible, please collect the following files and attach them to your support
request:

• Log file for Streaming Server - saved immediately after the problem occurred. Log files are stored in
the \Program Files\ColorfrontPlatform\log folder.

• Crash dump files - Crash dump files are saved in the \Program Files\ColorfrontPlatform\bin folder.

• Any possibly related non-sensitive metadata or sample file.

C.1. Log Viewer
The Log Viewer is available in the Streaming Player App for both AppleTV and iOS devices. It provides the
capability to inspect application logs, assisting in debugging and issue resolution.

Apple TV

To activate the Log Viewer on AppleTV, follow the swipe sequence on the remote control: left, right,
right, left, left.

To exit the viewer, simply use the back button.

iOS Devices

On iPad and iPhone devices, the Log Viewer can be activated with the sequence: tap, double tap,
double tap, tap.

To exit on iOS, you can use the dedicated exit button or swipe in any direction.
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Appendix D: Copyright, License and Trademark
Notices
Dolby License Notice and Trademark Acknowledgement

Dolby, Dolby Vision, Dolby Atmos, Dolby Cinema, Dolby
Theatre and the double-D symbol are registered trademarks of
Dolby Laboratories Licensing Corporation.

Confidential unpublished works. Copyright 2012-2025 Dolby
Laboratories. All rights reserved.

OpenEXR Software Development Kit
Copyright © 2004, Industrial Light and Magic, a divisionof Lucasfilm Entertainment Company Ltd.
Portions contributed and copyrightheld by others as indicated.
All rights reserved.
http://www.openexr.com/license.html

wkhtmltopdf
GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright © 2007 Free Software Foundation, Inc.
http://fsf.org/
XAMPP
GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright © 2009, Carsten Wiedmann. All rights reserved.
ffmpeg
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

Copyright © 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html

Freetype 2.3.9, 2.3.5
FreeType License (FTL)
Copyright © 2008 The FreeType Project (www.freetype.org). All rights reserved.
http://www.freetype.org/FTL.TXT

FTGL 2.1.3
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

FTGL - OpenGL font library
Copyright © 2001-2025 Henry Maddocks <ftgl@opengl.geek.nz>
Copyright © 2008 Sam Hocevar <sam@zoy.org>
Copyright © 2008 Sean Morrison <learner@brlcad.org>
http://ftgl.sourceforge.net/docs/html/index.html
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Inconsolata font
SIL OPEN FONT LICENSE
Version 1.1 - 26 February 2007

Created by Raph Levien using his own tools and FontForge. Copyright 2006 Raph Levien. Released under
the SIL Open Font License, http://scripts.sil.org/OFL.

Python 2.5.4 , 2.6, 2.7.4
BEOPEN.COM LICENSE AGREEMENT FOR PYTHON 2.0

Copyright © 2001-2025 Python Software Foundation; All Rights Reserved
http://docs.python.org/license.html

LIBXML2 and LIBXSLT2

Developed for the Gnome project. Copyrighted under the MIT License.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenSSL

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses
are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact
openssl-core@openssl.org.

OpenSSL License

Copyright © 1998-2025 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
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OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ''AS IS'' AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation
was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. If
this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used. This can be in the form of a textual message at program startup or in documentation (online
or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being
used are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution license (including the
GNU Public License.)

XMLSEC library

MIT license, Copyright © 2002-2025 Aleksey Sanin. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

ASDCP

Open Source License, Copyright © 2003-2025, John Hurst. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided with the
distribution. The name of the author may not be used to endorse or promote products derived from this
software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
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SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Chromium Embedded Framework

Copyright (c) 2008-2025 Marshall A. Greenblatt. Portions Copyright (c) 2006-2025 Google Inc. All rights
reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of Google Inc., nor the name Chromium Embedded Framework, nor the names of its
contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

imscJS

Copyright (c) 2016, Pierre-Anthony Lemieux (pal@sandflow.com) All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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RegxmllibC

Copyright (c) Pierre-Anthony Lemieux (pal@palemieux.com) All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Haivision/SRT Haivision/SRT, Secure, Reliable, Transport is licensed under the Mozilla Public License
2.0.

LibAv Libav is licensed under the GNU Lesser General Public License (LGPL) version 2.1 Libav is packaged
in binary form as a dynamic library within the application and is compiled without --enabled-gpl and
without --enable-nonfree. We get it from: git://git.libav.org/libav.git

LibArchive The libarchive distribution as a whole is Copyright by Tim Kientzle:

Copyright (c) 2003-2025 Tim Kientzle All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met: 1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer in this position and unchanged. 2.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S)
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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